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Product overview

This chapter presents an overview of the hardware components of the HP xw4550 Workstation,
including the following topics:
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●

Product features on page 2

●

Product specifications on page 8

●

ENERGY STAR on page 13

●

Dual-core processors on page 14

●

HP Cool Tools on page 14

1

Product features
This section describes the product features of the HP xw4550 Workstation.

System board architecture
The following figure shows the HP xw4550 Workstation block diagram.
Figure 1-1 HP xw4550 Workstation system board block diagram

Component view
The following figure shows components of a typical HP xw4550 Workstation. Drive configurations might
vary.
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For information about supported replacement parts, see: http://partsurfer.hp.com.
Figure 1-2 HP xw4550 Workstation component view

Table 1-1 Component view
Item
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Description

Item

Description

1

Power supply

9

Processor

2

Hard drive

10

Memory module

3

Optical drive

11

System board

4

Side access panel

12

PCI Express card

5

System fan

13

PCI card

6

Chassis

14

Speaker

7

Diskette drive

15

Front bezel

8

Processor heatsink
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Front panel components
The following image shows a typical HP xw4550 Workstation. Drive configurations might vary.
Figure 1-3 Front panel components

Table 1-2 Front panel components
Item

4

Symbol

Description

Item

Symbol

Description

1

Optical drive eject button

8

IEEE-1394 Connector (optional)

2

Power on light

9

Diskette drive eject button

3

Power button

10

Diskette drive activity light

4

Hard drive activity light

11

Diskette drive (optional)

5

Universal Serial Bus 2.0 (USB) (x2)

12

5.25–inch drive bays (x2)

6

Headphone connector

13

Optical drive activity light

7

Microphone connector

14

Optical drive
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Rear panel components
The following illustrations shows a typical HP xw4550 Workstation.
NOTE: The rear panel connectors are labeled with industry-standard icons and colors to assist you in
connecting your peripheral devices.
Figure 1-4 Rear panel components

Table 1-3 Rear panel components
Item
1

Symbol

Description
Universal chassis clamp opening

Item
7

Symbol

Description
Optional PCI Express graphics card
adapter
NOTE: When installed, disables the
workstation integrated graphics output.

2

Serial connector

8&9

USB 2.0 (x6)

3

Audio line-in connector (light blue)

10

Microphone connector (pink)

4

RJ-45 network connector

11

DVI integrated graphics connector
NOTE: Disabled when an optional
PCI Express graphics card is installed.
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5

Cable lock slot

12

VGA connector

6

Padlock loop

13

Power cord connector
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Serial number and COA label location
Each workstation has two unique serial number labels (1) and a Certificate of Authentication (COA) label
(2) (for Windows preinstalled workstations only). In general, the serial number labels can be found on
the top panel or on the side of the workstation and at the rear of the workstation. Keep this number
available when contacting customer service for assistance.
Figure 1-5 Serial number and COA label location
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Maximizing the airflow
●

Keep your workstation in an area where the airflow is not obstructed.

●

Keep the workstation off of surfaces where dust can gather.

●

Keep the front of the workstation clear of any obstruction.

●

Remove any dust on the front panel (vent area) and the rear fans with a small vacuum, compressed
air, or dust rag.

●

Keep the back of the workstation at least 0.15m (6 in.) away from a wall or other obstruction.

Figure 1-6 Maintain proper clearance

ENWW

Maximizing the airflow
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Product specifications
The following table lists the physical dimensions for the HP xw4550 Workstation.
Table 1-4 Physical characteristics
Weight (typical
configuration)

15.88 kg (35 lb)

Tower dimensions

45 cm (17.7 in.) high
16.8 cm (6.6 in.) wide
45.6 cm (17.9 in.) deep

Power supply
The power supply for the HP xw4550 Workstation is a 300-watt, 80Plus energy efficient power supply
compatible with Energy Star requirements. This section describes the power supply specifications.

Power supply description
This section describes the 80Plus power supply for the HP xw4550 Workstation.
Source voltage

Description

+3.33V

PCI, PCI Express, audio, SB600, RS690, super I/O, BIOS ROM, and on-board
logic

+5.08V

Storage (disk, optical, diskette), PCI, PCI Express, RS690, audio, keyboard/
mouse, input to on-board regulator, super I/O

+12V
+12 VCPU

PCI, PCI Express, system fans, storage (disk, optical, diskette)
Input to on-board regulator that supplies power for the processor

-12V

PCI, serial port

5.08 aux

Sleep circuitry

Table 1-5 Max current per rail
Voltage rail

Maximum continuous current

3.33V

16A

5.08V

19A

12 VCPU

11.5A

+12V

11A

–12V

0.15A

5.08V aux

2.0A

WARNING! Do not exceed 300 watts of total continuous output power.
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Power supply specifications
Table 1-6 Power supply specifications
Item

Description

Power supply

300-W custom power supply (Wide Ranging,
Active PFC)

Operating voltage range

90-264 VAC

Rated voltage range

100-240 VAC

Rated line frequency

50-60 Hz

Operating line frequency range

47-63 Hz

Rated input current

5.0A @ 100-120 VAC

Heat dissipation

Typical 431 Btu/hr..= (108 kg-cal/hr.)

(Configuration and software dependent)

Maximum 1331 Btu/hr. = (336 kg-cal/hr.)

Power Supply fan

2.5A @ 200-240 VAC

80 mm x 25 mm, variable speed

Energy Star compliant

Yes

FEMP Standby Power Compliant @ 115V (<2W in
S5 – Power Off)

Yes

Power Consumption in ES Mode – Suspend to
RAM (S3) (Instantly Available PC)

< 3W

Power consumption and cooling
The following example workstation configuration and supporting tables list the power consumption and
heat dissipation for a typical configuration based on primary power consumptions:
●

1 x AMD® OpteronTM 3.0 GHz processor 1222 Series

●

4 x 1-GB, DDR, 667-MHz memory modules

●

1 x FX1700 graphics card

●

1 x 250-GB SATA hard drive

●

1 x optical drive

●

1 x diskette drive

Table 1-7 Example 1 energy consumption
115 VAC
LAN
Enabled

ENWW

LAN
Disabled

230 VAC
LAN
Enabled

LAN
Disabled

100 VAC
LAN
Enabled

LAN
Disabled

On-Idle (ENERGY STAR®
Idle (S0))

50.9W

52.7W

51.0W

ENERGY STAR® PTEC
(Total Energy
Consumption) Windows

181.3W

176.2W

179.6W

Product specifications
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Table 1-7 Example 1 energy consumption (continued)
115 VAC
LAN
Disabled

LAN
Enabled

230 VAC
LAN
Enabled

100 VAC

LAN
Disabled

LAN
Enabled

LAN
Disabled

running Linpack and
Viewperf (S0)
Windows Busy Max (S0)

200.1W

192.0W

196.7W

ENERGY STAR®
“Sleep” (S3)*

2.93W

2.06W

6.58

2.36

2.80W

2.04W

ENERGY STAR®
“Standby” (Off) (S5)

1.69W

0.94W

2.00W

1.23W

1.67W

0.92W

* Energy Star low energy mode.

Table 1-8 Example 1 heat dissipation**
115 VAC
LAN
Enabled

LAN
Disabled

230 VAC
LAN
Enabled

LAN
Disabled

100 VAC
LAN
Enabled

LAN
Disabled

On-Idle (ENERGY
STAR® Idle (S0))

173.6 Btu/hr

179.7 Btu/hr

174.0 Btu/hr

ENERGY STAR® PTEC
(Total Energy
Consumption) Windows
running Linpack and
Viewperf) (S0)

618.6 Btu/hr

601.2 Btu/hr

612.8 Btu/hr

Windows Busy Max (S0)

682.9 Btu/hr

655.3 Btu/hr

671.3 Btu/hr

ENERGY STAR®
“Sleep” (S3)*

10.0 Btu/hr

7.03 Btu/hr

12.2 Btu/hr

8.05 Btu/hr

9.56 Btu/hr

6.96 Btu/hr

ENERGY STAR®
“Standby” (Off) (S5)

5.77 Btu/hr

3.21 Btu/hr

6.83 Btu/hr

4.20 Btu/hr

5.70 Btu/hr

3.14 Btu/hr

* Energy Star low energy mode.
** Heat dissipation is calculated based on the measured watts, assuming the service level is attained for one hour.

Configuration 2
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●

1 x AMD Opteron 2.0 GHz 1212 Series

●

2 x 512-GB, DDR2, 667-MHz memory modules

●

Integrated graphics

●

1 x 80 GB SATA hard drive

●

1 x optical drive

●

1 x diskette drive

Chapter 1 Product overview
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Table 1-9 Example 2 energy consumption
115 VAC
LAN
Enabled

LAN
Disabled

230 VAC
LAN
Enabled

LAN
Disabled

100 VAC
LAN
Enabled

LAN
Disabled

On-Idle (ENERGY STAR®
Idle (S0))

38.8W

36.9W

39.1W

ENERGY STAR® PTEC
(Total Energy
Consumption) Windows
running Linpack and
Viewperf) (S0)

96.6W

94.5W

99.5W

Windows Busy Max (S0)

112.3W

108.1W

115.3W

ENERGY STAR®
“Sleep” (S3)*

2.64W

1.78W

2.84W

2.10W

2.10W

1.79W

ENERGY STAR®
“Standby” (Off) (S5)

1.75W

0.98W

2.00W

1.25W

1.75W

0.95W

* Energy Star low energy mode.

Table 1-10 Example 2 heat dissipation**
115 VAC
LAN
Enabled

LAN
Disabled

230 VAC
LAN
Enabled

LAN
Disabled

100 VAC
LAN
Enabled

LAN
Disabled

On-Idle (ENERGY
STAR® Idle (S0))

132.4 Btu/hr

125.9 Btu/hr

133.5 Btu/hr

ENERGY STAR® PTEC
(Total Energy
Consumption) Windows
running Linpack and
Viewperf) (S0)

329.6 Btu/hr

322.6 Btu/hr

339.7 Btu/hr

Windows Busy Max (S0)

383.3 Btu/hr.

369.0 Btu/hr

393.5 Btu/hr

ENERGY STAR®
“Sleep” (S3)*

9.01 Btu/hr

6.08 Btu/hr

9.69 Btu/hr

7.17 Btu/hr

8.91 Btu/hr

6.11 Btu/hr

ENERGY STAR®
“Standby” (Off) (S5)

5.97 Btu/hr

3.34 Btu/hr

6.83 Btu/hr

4.27 Btu/hr

5.97 Btu/hr

3.24 Btu/hr

* Energy Star low energy mode.
** Heat dissipation is calculated based on the measured watts, assuming the service level is attained for one hour.

This product is in compliance with US executive order 13221, WOL (wake on LAN) disabled.
NOTE: When you power down your workstation with the power button on the front panel, the power
consumption falls below 10W. To reach zero power consumption, remove power from the workstation.
For additional information on power-saving features, see your operating system documentation.
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System fans
The workstation includes a rear chassis fan, one processor heatsink fan, and one power supply fan. An
optional front PCI fan is available for special considerations, such as graphics PCI cards.
Resetting the power supply
If an overload triggers the power supply overload protection, all power is immediately disconnected. To
reset the power supply unit:
1.

Disconnect the power cord.

2.

Determine what caused the overload and correct the problem.

3.

Reconnect the power cord, apply power, and reboot the workstation.

NOTE: When you power down your workstation with the power button on the front panel, the power
consumption falls below 10W. To reach zero power consumption, remove power from the workstation.
For additional information on power-saving features, see your operating system documentation.

Environmental specifications
This section describes environmental specifications of your workstation.
Table 1-11 Environmental specifications
Temperature (operating)

40°F to 95°F (5°C to 35°C)

Temperature (non-operating)

-40°F to 140°F (-40°C to 60°C)

Humidity (operating)

8% to 85% RH, non-condensing

Humidity (non-operating)

8% to 90% RH, non-condensing

Altitude (operating)

0 to 10,000 ft. (3,048m)

Altitude (non-operating)

0 to 30,000 ft. (9,144m)

Shock (operating)

1/2-sine: 40G, 2-3 ms

Shock (non-operating)

1/2-sine: 160 cm/s, 2-3 ms (~100 g)
Square: 20G, 422 cm/s
NOTE: Values represent individual shock events and are not
indicative of repetitive shock events.

Vibration (operating)

Operating random: 0.5G rms, 5–300 Hz

Vibration (non-operating)

Random: 2.0G (rms), 10-500 Hz
NOTE:
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ENERGY STAR
Hewlett-Packard computers marked with the ENERGY STAR® Logo are compliant with the applicable
U.S. Environmental Protection Agency (EPA) ENERGY STAR specifications for computers. The EPA
ENERGY STAR Logo does not imply endorsement by the EPA. As an ENERGY STAR Partner, HewlettPackard Company has determined the products marked with the ENERGY STAR Logo are ENERGY
STAR qualified as per the applicable ENERGY STAR guidelines for energy efficiency. The following
logo will appear on all ENERGY STAR qualified computers:
Figure 1-7 ENERGY STAR logo

The ENERGY STAR Computers Program was created by the EPA to promote energy efficiency and
reduce air pollution through more energy-efficient equipment in homes, offices, and factories. One way
products achieve this is by reducing power consumption when not being used through the Microsoft
Windows ® Power Management feature.
The Power Management feature allows the computer to enter into a low-power or “sleep” mode after a
period of user inactivity. When used with an external ENERGY STAR compliant monitor, this feature
will also support similar power management features of the monitor. To take advantage of this energy
savings:
●

The Power Management feature has been preset to power down the computer after 30 minutes of
user inactivity.

●

The Power Management feature has been preset to power down the monitor after 15 minutes of
user inactivity.

Both the computer and monitor can be woken from “sleep” mode through user interaction with any of
the computer’s input devices (for example; mouse, keyboard, and others). When configured with Wake
On LAN (WOL) enabled, the computer can also be awoken by a network signal.
More information on the energy and financial savings potential of the Power Management Feature can
be found at the EPA’s ENERGY STAR Power Management website: http://www.energystar.gov/
powermanagement.
More information on the ENERGY STAR program and its environmental benefits is available by visiting
the EPA ENERGY STAR Web site: http://www.energystar.gov.
CAUTION: Using the Energy Save Monitor feature with non–ENERGY STAR compliant monitors may
cause video distortion when the Energy Save timeout occurs.
NOTE:

ENERGY STAR is not supported on Linux workstations.

If you must restore the operating system, reset the ENERGY STAR settings (if applicable) after the
restore.
Using the ENERGY STAR Save Monitor feature with non-ENERGY STAR-compliant monitors might
cause video distortion when the Energy Save timeout occurs.

ENWW
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NOTE: Not all configurations of the HP xw4550 Workstation are Energy Star compliant. For
information on configurations of this workstation that are Energy Star compliant, contact you HP sales
representative.
To verify the factory default power settings for your product, select Start>Control Panel and doubleclick Power Options.

Dual-core processors
The HP xw4550 Workstation contains a dual-core processor. Dual-core processors provide the
workstation with two true processors in a single socket, and can better handle the load of multi-threaded
applications (such as rendering an image in Digital Content Creation) and highly multi-tasked
environments (such as running several productivity applications while listening to music).

HP Cool Tools
The HP xw4550 Workstation comes preloaded with additional software that is not automatically installed
when you first boot your operating system. Additionally, a number of valuable preinstalled tools on your
workstation can enhance your workstation experience. To access or learn more about these
applications:
●

Open the HP Cool Tools folder by selecting Start>All Programs>HP Cool Tools.

●

Select the HP Cool Tools icon on the desktop.

To learn more about these applications, click HP Cool Tools—Learn More.
To install or launch the applications, click the appropriate application.
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Configuring and restoring the operating
system

This chapter describes configuring and restoring the operating system.
●

Setting up Microsoft Windows Vista Business software on page 15

●

Setting up Microsoft Windows XP Professional software on page 18

●

HP Backup and Recovery Manager restore points on page 22

●

Protecting the software on page 22

●

HP software on page 22

●

Setting up Red Hat Linux on page 23

●

Setting up Red Flag Linux on page 24

If your workstation was shipped with a preinstalled operating system, it is configured automatically the
first time your workstation is powered on.
CAUTION: Do not add optional hardware or third-party devices to the HP workstation until the
operating system is successfully configured. Adding hardware might cause errors and prevent the
operating system from configuring correctly.

Setting up Microsoft Windows Vista Business software
This section describes how to configure and restore Microsoft® Windows Vista® Business software.

Configuring the Windows Vista Business operating system
Configuring the software
The operating system is configured when you first apply power to the workstation. This process takes
approximately 5 to 10 minutes. Carefully follow the instructions on the screen to complete the
configuration.
CAUTION: After the automatic configuration has begun, do not power off your workstation until this
process completes. Powering off your workstation during the configuration process might damage the
software that runs the system.
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For complete operating system installation and configuration instructions, see the operating system
documentation provided with your workstation. Additional information is available in the online help tool
after you successfully configure the operating system.

Selecting a language
At the first boot of the factory preinstalled operating system, you might be prompted to select a language
for the operating system. After selecting the language, read and follow the instructions on the screen
to complete configuration of the operating system. This process might take quite a while, depending on
the system hardware configuration and the language choice. During the process, do not power off your
workstation unless you are directed to do so.
NOTE: After you have selected a language during initial boot of the operating system, the language
will be locked in on the hard drive. If the system is restored with HP Backup and Recovery, only the
previously selected language can be installed. If using RestorePlus! DVDs, the RestorePlus! DVD
checks for the language stored on the hard drive and restores only the original preinstalled language.
If a new hard drive is installed or no language is found on the disk, the RestorePlus! DVD installs any
language requested.

Creating recovery disks
Refer to Restoring the Windows Vista Business operating system on page 16 for details on the HP
Backup and Recovery process.

Installing or upgrading device drivers
Required device drivers must be installed after you configure the operating system, and before you
install their respective hardware devices. In addition, for optimum performance, your operating system
must have the most recent updates, patches, and software fixes. Access the following resources for
driver and software updates:
●

See the Microsoft site to obtain updates for your operating system, including current patches and
software fixes.

●

Device drivers are provided on a CD supplied with the peripheral device.

●

Some peripheral device drivers developed for Microsoft Windows XP Professional or Microsoft
Windows Vista Business might not be shipped with your workstation. To locate the current device
drivers, see: http://www.hp.com/support/workstation_swdrivers.

●

For documentation on installing drivers and workstation operation, see: http://www.hp.com/
support/workstation_manuals .

Restoring the Windows Vista Business operating system
Your workstation has a several methods to restore your Windows Vista operating system to a nearfactory state, or to the state of the system at a predefined restore point. Your system has a recovery
partition on the system hard drive that contains software and data required for the restore process as
described in the following sections.
NOTE: If you must restore the operating system with Windows Vista Business OEM DVDs (installing
without using the Restore Plus! DVDs), you must call Microsoft to provide a Stock Keeping Unit (SKU)
number. The SKU information is on the service tag and is the OS product number in the lower right hand
section of the tag. It should display “OS: XXXXXXX,” where “XXXXXXX” is the OS product number.
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Using the HP Backup and Restore process
The Windows operating system and device drivers (for devices shipped with the system) are reinstalled
using this process. The HP Backup and Restore (HPBR) process can be executed from DVD, CD, or
from the recovery partition contained on your system hard drive. Select Start>All Programs>HP
Backup & Recovery>HP Backup and Recovery Manager to launch the HPBR.
CAUTION: Backup your data before you attempt any operating system restore. All data on the
Windows partition will be deleted when you perform a system restore using the HPBR process. However,
the recovery partition on the system drive and other partitions should not be affected.
Creating system recovery DVDs or CDs
You can create a set of the DVDs or CDs from your system if you have a DVD or CD writer. After
launching the HP Backup and Restore Manager, you can create ISO images of the factory image, or
write them directly to CD or DVD media. You can also create a supplemental HP Backup and Recovery
Manager CD. (There may be additional CDs you can create depending on the options you purchased.)
You also have the option to move images of the CDs to another location, such as a network share, to
be written to DVD or CD at a later time or from another system.
Restoring from HPBR DVDs or CDs
To start the system recovery process, boot from the previously-created DVD or CD and carefully follow
the online instructions.
Restoring directly from the recovery partition
Follow these steps to start the HPBR system restore process from the Recovery Manager:
1.

Boot the workstation.

2.

When prompted on the boot splash screen to enter the Recovery Manager, press F11.

3.

Follow the prompts to restore the system to a factory-like condition.

Reclaiming hard disk space from the recovery partition
To free up disk space, you can remove only the recovery partition, or you can completely uninstall the
HP Backup and Recovery Manager application.
CAUTION:

If the recovery partition is removed:

- The F11 Emergency Recovery function is not available.
- The ability to recover the system is lost.
- Any recovery images contained in the recovery partition are deleted.
- The ability to create a recovery media set is lost.
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●

Removing only the recovery partition – The recovery partition can be removed by selecting
Remove HP Recovery Partition in the HP Backup & Recovery program folder. When the HP
Recovery Partition is removed; the recovery partition is deleted, the user partition is extended to
reclaim the unused hard drive space, and the F11 boot prompt is removed. The HP Backup and
Recovery Manager application remains and can be used for data backup and restore.

●

Uninstalling the HP Backup and Recovery Manager application – The HP Backup and
Recovery Manager application can be uninstalled using the Windows Control Panel>Programs
Setting up Microsoft Windows Vista Business software
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and Features utility. When the application is uninstalled, the recovery partition is deleted, the user
partition is extended to reclaim the unused space, and the F11 boot prompt is removed. Emergency
recovery as well as data backup and recovery is not possible after the application is uninstalled.

Ordering backup software
If you are unable to create system recovery CDs or DVDs, you can order a recovery disk set from the
HP support center.
NOTE:

Before calling HP to order the software, have your workstation serial number available.

To obtain the support center telephone number for your region:
1.

See: http://www.hp.com/support/contactHP.

2.

Select your region.

3.

Under the Call HP heading, select Technical support after you buy.

Transferring files and settings using Windows Easy Transfer
Windows Easy Transfer, the Microsoft data migration tool, provides a guide that helps you choose what
files and data to transfer from another Windows computer to your Windows Vista Business workstation
and how to transfer it. You can use one of the following interconnect or storage methods with Windows
Easy Transfer to migrate data from another Windows computer to your workstation:
●

Network – Can be used when both the source computer and your workstation are connected to
the same network.

●

Easy Transfer Cable – A specially designed USB cable that can connect the source computer to
your workstation when completing a Windows Easy Transfer. Note that an Easy Transfer Cable is
not a standard USB cable, but is also commonly available from local electronic suppliers.

●

DVDs or CDs – Can be used if you have writeable DVD or CD drives on the source computer and
your workstation.

●

USB flash drive or an external hard drive – Can access both the source computer and your
workstation.

To use the Windows Easy Transfer tool, select Start>All Programs>Accessories>System
Tools>Windows Easy Transfer.
NOTE: For more information on using Windows Easy Transfer, see: http://www.microsoft.com/
windows/products/windowsvista/features/details/easytransfer.mspx.

Setting up Microsoft Windows XP Professional software
This section describes how to configure and restore Microsoft® Windows XP™ Professional software.

Configuring Microsoft Windows XP Professional software
This section describes how to configure the Windows XP software.
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Configuring the software
The operating system is configured when you first apply power to the system. This process takes
approximately 5 to 10 minutes. Carefully follow the instructions on the screen to complete the
configuration.
CAUTION: After the automatic configuration has begun, do not power off your workstation until this
process completes. Powering off your workstation during the configuration process might damage the
software that runs the system.
For complete operating system installation and configuration instructions, see the operating system
documentation provided with your workstation. Additional information is available in the online help tool
after you successfully configure the operating system.

Selecting a language
At the first boot of the factory preinstalled operating system, you might be prompted to select a language
for the operating system. After selecting the language, read and follow the instructions on the screen
to complete the configuration of the operating system. This process might take quite a while, depending
on the system hardware configuration and the language choice. During the process, do not power off
your workstation unless you are directed to do so.
NOTE: After you have selected a language during initial boot of the operating system, the language
will be locked-in on the hard drive. If the system is restored with HP Backup and Recovery, only the
previously selected language can be installed. If using RestorePlus! DVDs, the RestorePlus! DVD
checks for the language stored on the hard drive and restores only the original preinstalled language.
If a new hard drive is installed or no language is found on the disk, the RestorePlus! DVD installs any
language requested.

Creating recovery disks
When a new operating system is installed, you are prompted to create recovery disks. Refer to Restoring
the Windows XP Professional operating system on page 20 for details on the HP Backup and Recovery
process.

Installing or upgrading device drivers
Required drivers must be installed after you configure the operating system, and before you install their
respective hardware devices. In addition, for optimum performance, your operating system must have
the most recent updates, patches, and software fixes. Access the following resources for driver and
software updates:
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●

See the Microsoft site to obtain updates for your operating system, including current patches and
software fixes.

●

Device drivers are provided on a CD supplied with the peripheral device.

●

Some peripheral device drivers developed for Windows XP or Vista might not be shipped with your
workstation. To locate the current device drivers, see: http://www.hp.com/support/
workstation_swdrivers.

●

For documentation on installing drivers and workstation operation, see: http://www.hp.com/
support/workstation_manuals .

Setting up Microsoft Windows XP Professional software
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Restoring the Windows XP Professional operating system
Your workstation has several methods to restore your Windows XP operating system to a near-factory
state, or to the state of the system at a predefined snapshot in time. Your system has a recovery partition
on the system hard drive that contains software and data required for the restore process as described
in the following sections.

The RestorePlus! process
The Windows operating system and device drivers (for devices shipped with the system) are reinstalled
using this process. Some application software may not be restored using the RestorePlus! process. In
this case you must install the application software from the appropriate application CD. The RestorePlus!
process can be executed from CD or from the recovery partition contained on your system hard drive.
CAUTION: Back up your data before you attempt any operating system restore. All data on the
Windows partition will be deleted when you restore using the RestorePlus! process. However, the
recovery partition on the system drive and other partitions should not be affected.
Creating a RestorePlus! CD
You can create a set of the CDs from your system if you have a CD writer. When you first boot your
system, you will be prompted to make CDs for RestorePlus!, the Windows operating system, and a
supplemental HP Backup and Recovery Manager CD. (There may be additional CDs you can create
depending on the options you purchased.) You also have the option to move images of the CDs to
another location, such as a network share, to be written to CD at a later time or from another system.
Restoring from RestorePlus! CDs
The RestorePlus! process can be started by powering up from the RestorePlus! CD.
Restoring from RestorePlus! on the Recovery Partition
Follow these steps to start the RestorePlus! process from the Emergency Recovery menu:
1.

Boot the workstation.

2.

Press F11 when prompted during the boot process to enter the Emergency Recovery menu. The
F11 prompt appears briefly during the boot process.
If you have a recovery partition but the F11 prompt is not visible:

3.

a.

Press F10 to access the setup menu.

b.

Select Advanced from the drop down menu.

c.

Select Power-On Options.

d.

Ensure that the F11 prompt is set to Displayed.

e.

Ensure that Factory Recovery Boot Support is set to Enabled.

f.

Reboot the workstation and press F11 when prompted.

Select Recover PC’s factory installed operating system, drivers, utilities, and applications
from the Emergency Recovery menu.

NOTE:
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Reclaiming hard disk space from the recovery partition
The recovery partition can be removed to reclaim the hard drive space.
CAUTION:

If the recovery partition is removed:

- The F11 Emergency Recovery function is not available.
- The ability to recover the system from data on the recovery partition is lost.
- Any recovery images contained in the recovery partition are deleted.
- The ability to create a recovery media set is lost.
To free up disk space, you can remove only the recovery partition, or you can completely uninstall the
HP Backup and Recovery Manager application.
CAUTION: If you uninstall the HP Backup and Recovery Manager application, emergency recovery
and data backup and recovery are no longer possible.
●

Removing only the recovery partition – The recovery partition can be removed by selecting
Remove HP Recovery Partition in the HP Backup & Recovery program folder. When the HP
Recovery Partition is removed; the recovery partition is deleted, the user partition is extended to
reclaim the unused hard drive space, and the F11 boot prompt is removed. The HP Backup and
Recovery Manager application remains and can be used for data backup and restore.

●

Uninstalling the HP Backup and Recovery Manager application – The HP Backup and
Recovery Manager application can be uninstalled using the Windows Control Panel>Programs
and Features utility. When the application is uninstalled, the recovery partition is deleted, the user
partition is extended to reclaim the unused space, and the F11 boot prompt is removed. Emergency
recovery as well as data backup and recovery is not possible after the application is uninstalled.

CAUTION: Deleting the recovery partition or uninstalling the HP Backup and Recovery Manager
application reduces or eliminates the ability to recover the system.

Ordering backup software
If you are unable to create system recovery CDs or DVDs, you can order a recovery disk set from the
HP support center.
NOTE:

Before calling HP to order the software, have your workstation serial number available.

To obtain the support center telephone number for your region:
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1.

See: http://welcome.hp.com/country/us/en/wwcontact_us.html.

2.

Select your region.

3.

Under the Call HP heading, select Technical support after you buy.

Setting up Microsoft Windows XP Professional software
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HP Backup and Recovery Manager restore points
HP Backup and Recovery Manager is preinstalled on your workstation. This software allows you to
backup and restore your system and data. You will be prompted to make RestorePlus! CDs at the first
boot of the system. An Initial Restore Point (IRP) will be created automatically. This restore point is a
complete snapshot of the system partition at the time the IRP was created. The IRP is stored in the
recovery partition on the system hard drive, but you can also write the IRP to CDs, DVDs, or copy it to
another location. The restore point can be used to return the system partition back to the state the system
was when captured.

Restoring from the HP Backup and Recovery Manager restore point CD or
DVDs
The HP Backup and Recovery Manager (HPBR) restore point can be written to CD or DVDs and used
to restore the system. Typically you would used the CD/DVD set if the hard drive has been replaced or
all partitions have been corrupted. Boot the system from the HPBR restore point CD/DVD and follow
the online instructions.

Restoring from the HP Backup and Recovery Manager restore point on the
Recovery Partition
The HP Backup and Recovery Manager (HPBR) Initial Restore Point is stored in the system recovery
partition and can be restored using the Emergency Recovery menu. Boot your system and press the
F11 key when prompted to enter the Emergency Recovery menu. The F11 prompt appears briefly during
the boot process. From the Emergency Recovery menu, choose Recover PC to a specific point in
time and follow the instructions.

Protecting the software
To protect software from loss or damage, keep a backup copy of all system software, applications, and
related files stored on the hard drive. See the operating system or backup utility documentation for
instructions on making backup copies of data files.

HP software
The following HP software may be installed on your workstation depending on the operating system and
options:
●

Computer Setup (F10) Utility and diagnostic features

●

HP Support Software including device drivers

●

Security Management tools (optional)

●

Software Support Management tools

Additional software is available for download:
●

HP Client Manager Software is available at: http://www.hp.com/go/easydeploy.

●

System Software Manager is available at: http://www.hp.com/go/ssm.

NOTE:
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Setting up Red Hat Linux
This section describes how to configure and restore Red Hat Linux-preinstalled workstations. Follow
the instructions in this section to set up your operating system and software.
After the boot process completes, you can view additional HP Linux documentation by opening your
Internet browser (the browser is automatically set to use the local HP documentation page as its default).
You can also access Linux Web links for Red Hat (Internet access required) by using your Internet
browser.
For additional information about setting up Linux-preinstalled workstations, refer to the HP User Manual
for Linux at: http://www.hp.com/support/linux_user_manual.
For more information about HP and Linux, see: http://www.hp.com/linux.

Starting the Linux operating system
The first time your workstation is booted, the Red Hat First Boot utility displays. This program enables
you to enter your password, network, time, and keyboard settings for your workstation.
CAUTION: After the automatic installation has begun, do not power down your workstation until the
process is complete. Powering down your workstation during the installation process might damage the
software that runs your workstation or prevent its proper installation.
When you enable the YPBind feature in the Network tab of the Linux Setup Tool, you might get a blank
screen for about 15-30 seconds after you have selected and saved all of your settings and exited the
utility. This behavior is normal. The boot process continues to execute after the screen returns.

Restoring the Linux operating system
To restore the Linux operating system, you must have the HP Driver CD and RHEL restore media.
Download the latest HP Driver CD to get any new enhancements. This section provides information on
how to:
●

Create restore media.

●

Download the latest HP driver CD contents.

●

Reinstall the factory Linux image with the HP driver CD contents.

NOTE: Linux does not support mixed drive types for a manufacturing preload. When restoring the
operating system, mixed drive types can be handled with the restoring media.

Creating restore media
Workstations that are preloaded with HP Red Hat Linux have an icon on the display desktop with the
label “Red Hat ISOs.” Select this icon to go to the /iso directory. The /iso directory contains all of the
ISO images used to preload your HP Red Hat Linux operating system. To recover or restore the original
image, follow the instructions in the README file in the /iso directory to record the ISO image file onto
CDs.
NOTE: HP recommends that you record the ISO recovery images to CD as backup files to be used
in the event of a possible disk failure.
The /iso directory also contains an ISO image of the HP Driver CD used to create your preloaded system.
You can either use this version or download the latest version.
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Downloading the latest HP driver CD contents
Download the latest HP Driver CD to receive any new enhancements as follows:
1.

See http://www.hp.com/support/workstation_swdrivers.

2.

Find your workstation model and operating system.

3.

Select your driver CD under Software, and follow the directions under Release Notes.

Reinstalling the factory Linux image with the HP driver CD contents
1.

Boot your workstation from the Binary CD 1 of the restore media.

2.

Insert the Linux operating system CDs.

3.

Continue following the prompts until the operating system is successfully installed.

4.

Configure the X server to start on reboot.

5.

Reboot your workstation.

6.

Follow the prompts to set up your system with the Red Hat First Boot utility.

7.

When prompted in First Boot to add additional CDs, insert the HP Driver CD into the optical drive
tray of your workstation.

8.

Select Install next to Additional CDs. The HP Driver CD window opens.

9.

Select Press to begin install.
When the install is done, you will have two options available—Reboot now... on the left side
and Press to continue, reboot later... on the right side.

10. Select Reboot now...

Upgrading device drivers
To upgrade a Linux device driver, see: http://www.hp.com/support/workstation_swdrivers.

Setting up Red Flag Linux
Hewlett-Packard offers the Red Flag Linux operating system as a preloaded option on the HP xw4550
Workstation in certain countries, but does not, however, support the Red Flag Linux operating system.
For more information on Red Flag Linux and the Red Flag operating system software, see:
http://www.redflag-linux.com.
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System management

This chapter describes the various tools and utilities that support system management on the
workstation, and include information on the following sections:
●

Computer Setup (F10) Utility on page 25

●

Workstation management on page 32

Computer Setup (F10) Utility
The Computer Setup (F10) Utility enables you to:
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●

Change factory default settings and set or change the system configuration, which might be
necessary when you add or remove hardware.

●

Determine if all of the devices installed on the workstation are recognized by the system and
functioning properly.

●

Determine information about the operating environment of the workstation.

●

Solve system configuration errors detected but not automatically fixed during the Power-On SelfTest (POST).

●

Establish and manage passwords and other security features.

●

Establish and manage energy-saving time-outs (not supported for Linux platforms).

●

Modify or restore factory default settings.

●

Set the system date and time.

●

Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

●

Modify the boot order of installed mass storage devices such as SATA, diskette drives, optical
drives, network drives, and LS-120 drives.

●

Configure the boot priority of SATA hard drive controllers.

●

Enable or disable Network Server Mode, which enables the workstation to boot the operating
system when the power-on password is enabled with or without a keyboard or mouse attached.
When attached to the system, the keyboard and mouse remain locked until the power-on password
is entered.

●

Select POST Messages Enabled or Disabled to change the display status of POST messages.
POST Messages disabled suppresses most POST messages, such as memory count, product
name, and other non-error text messages. If a POST error occurs, the error is displayed regardless

Computer Setup (F10) Utility
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of the mode selected. To manually switch to POST Messages Enabled during POST, press any
key (except F1 through F12).
●

Establish an Ownership Tag, the text of which is displayed each time the system is powered on or
restarted.

●

Enter the Asset Tag or property identification number assigned by your company to this
workstation.

●

Enable power-on password prompting during system restarts (warm boots) and power-on.

●

Hide or make available the integrated I/O functionality, including the serial, or USB ports, audio, or
embedded network interface controller (NIC). Any hidden devices are inaccessible and increase
overall system security.

●

Enable or disable removable media boot ability.

●

Enable or disable removable media write ability (when supported by hardware).

●

Replicate your system setup by saving system configuration information on diskette and restoring
it on one or more workstations.

●

Execute self-tests on specified SATA hard drives (when supported by the drive).

BIOS ROM
The BIOS of the computer is a collection of machine language programs stored as firmware in ROM.
The BIOS ROM includes such functions as POST, PCI device initialization, plug-in-play support, power
management activities, and the Computer Setup (F10) Utility. The firmware contained in the BIOS ROM
supports the following systems and specifications:
●

Microsoft WHQL

●

Alert-On-LAN (AOL) and Wake-On-LAN (WOL)

●

ACPI 1.0 and OnNow

●

SMBIOS 2.3.5

●

PC98/99/00 and NetPC

●

PXE boot ROM for the integrated LAN controller

●

BIOS Boot Specification 1.01

●

Enhanced Disk Drive Specification 3.0

●

“El Torito” Bootable CD-ROM Format Specification 1.0

●

ATAPI Removable Media Device BIOS Specification 1.0

●

MPS Specification 1.4 (for booting Linux SMP)

The BIOS ROM is a 1MB Serial Peripheral Interface (SPI) part. The runtime portion of the BIOS resides
in a 128-K block from E0000h to FFFFFh.
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Using the Computer Setup (F10) Utility
You can only open the Computer Setup (F10) Utility by powering on the workstation or restarting the
workstation. To access the Computer Setup (F10) Utility menu:
1.

Power on or restart the workstation.

2.

Press the F10 key as soon as your display is active and you see F10=Setup appear in the lower
right corner of the screen.
NOTE: If you do not press F10 at the appropriate time, try again. Turn the workstation off, then
on, and press F10 again to access the utility, or press the Ctrl + Alt + Delete keys before boot if
you miss the opportunity to press F10.

3.

Select your language from the list and press the Enter key. In the Computer Setup (F10) Utility
menu, five headings are displayed: File, Storage, Security, Power, and Advanced.

4.

Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and down)
keys to select the option you want, and press Enter.

5.

To apply and save changes, select File>Save Changes and then select F10=YES.
●

If you have made changes that you do not want applied, select Ignore Changes and then
select F10=YES.

●

To reset to factory settings, select File>Default setup>Restore Factory Settings as
Default. Press F10 to accept the changes. Select Apply Defaults and Exit. This option
restores the original factory system defaults.

CAUTION: Do not power off the workstation while the ROM is saving your Computer Setup (F10)
Utility changes because the Complementary Metal-Oxide Semiconductor (CMOS) could become
corrupted. After you exit the F10 Setup screen, it is safe to disconnect power from the workstation.

Computer Setup (F10) Utility menu
NOTE: The following content is subject to change with new BIOS releases, so your menu might be
different than shown.
Table 3-1 Computer Setup (F10) Utility menu descriptions
Heading
File
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Option
System
Information

Description
Lists:
●

Product Name

●

SKU Number

●

Processor Type/Speed/Stepping

●

Cache Size (L1/L2)

●

Installed Memory Size

●

Integrated MAC

●

System BIOS

●

Chassis Serial Number

●

Asset Tracking Number

Computer Setup (F10) Utility
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Table 3-1 Computer Setup (F10) Utility menu descriptions (continued)
Heading

Option

Description

About

Displays copyright information.

Set Time and
Date

Enables you to set system time and date.

Flash System
ROM

CD-ROM – Enables you to upgrade the BIOS from a ROM image on CD.
NOTE: Optical drives must be in Legacy or Native mode.
USB – Enables you to upgrade the BIOS from a ROM image on a USB drive or memory stick.

Replicated
Setup

Save to Removable Media
Saves the system configuration, including CMOS, in the QSETUP.TXT file. This file can be saved
to a formatted, blank 1.44-MB diskette or to a USB-connected storage device.
Restore from Removable Media
Restores system configuration from a diskette.

Default Setup

Save Current Settings as Default
Saves the current settings as default settings for the next operation.
Restore Factory Settings as Default
Restores the factory settings as the default settings for the next operation.

Storage

Apply Defaults
and Exit

Restores factory default settings.

Ignore Changes
and Exit

Exits the computer setup without applying or saving any changes.

Save Changes
and Exit

Saves changes to system configuration and exits the computer setup.

Device
Configuration

Lists all installed non-SCSI storage devices and provides options for getting specific information
about each device.
Hard Disk
Provides information about the hard disk drives in the system.
CD-ROM
Provides information about the optical drives in the workstation.
Diskette Type (for legacy diskette drives only) identifies the highest capacity media type accepted
by the diskette drive. Options are 3.5" 1.44 MB, 5.25" 1.2 MB, and Not Installed.

SATA defaults

Restores or
resets SATA
defaults

Default Values
Resets devices to their SATA default configuration.
Multisector Transfers options are 8, 16, and Disable; 16 is default.
Transfer Mode specifies the active data transfer mode. Options (subject to device capabilities) are
Max UDMA, PIO 0, Max PIO, Enhanced DMA, and Ultra DMA0; Max UDMA is default.
Translation Mode enables BIOS to automatically determine the translation mode used to configure
a previously formatted SATA or USB mass storage device. This prevents you from having to know
how the mass storage device was previously formatted.
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Table 3-1 Computer Setup (F10) Utility menu descriptions (continued)
Heading

Option

Description
Ordinarily, the translation mode selected automatically by the BIOS should not be changed. If the
selected translation mode is not compatible with the translation mode that was active when the
disk was partitioned and formatted, the data on the disk will be inaccessible.
Translation Mode Options are Automatic, Bit Shift, LBA Assisted, Use (Cylinders, Heads, Sectors),
and Off; Automatic is default.

Storage Options

Removable Media Boot
Enables/disables ability to boot the system from removable media.
Legacy Diskette Write
Enables/disables ability to write data to removable media.
SATA Emulation
Sets the SATA emulation mode with the following options:
●

RAID–RAID OPROM executes. This emulation mode offers the best performance and most
functionality.

●

LEGACY MODE IDE – Offers standard SATA support (four ports only).

●

NATIVE MODE IDE – Offers full SATA and SATA-II functionality with no support for RAID.

DPS Self-test

Enables you to select a drive test for a SATA drive. It is not available for RAID configurations.

Boot Order

Enables you to configure the boot, diskette drive, and hard drive orders by physically reordering
the menu entries. The default boot order presents these selections:
●

ATAPI – CD-ROM Drive

●

Diskette Drive

●

USB Device

●

Hard Drive

●

Broadcom Ethernet controller

Press Enter to drag a device to a preferred place. Press F5 to remove the device from consideration
as a bootable device.
NOTE: MS-DOS drive lettering assignments might not apply after a non-MS-DOS operating
system has started.
Boot devices can be disabled from participating in the boot order process. These order changes
are reconciled with the IPL/BCV historical information and stored in the physical ROM part when
the F10 Setup changes are confirmed with File/Save Changes and Exit.
You can temporarily override the boot order
. To boot one time from a device other than the default device specified in Boot Order, restart the
workstation and press F9 when the F9=Boot Menu message appears on the screen. After POST
completes, a list of bootable devices is displayed. Use the arrow keys to select the preferred
bootable device and press Enter. The workstation then boots from the selected non-default device
for this one time.
Security

Setup Password Enables you to set and enable setup (administrator) password.
NOTE: If the setup password is set, it is required to change computer setup options, flash the
ROM, and make changes to certain PNP settings under Windows.
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Table 3-1 Computer Setup (F10) Utility menu descriptions (continued)
Heading

Option

Description

Power-On
Password

Enables you to set and enable the power-on password.

Password
Options

Lock Legacy Resources–Prevents the operating system from changing resources to serial and
diskette controller.
Setup Browse Mode–If a setup password is created, this mode enables read-only access to the
F10 Setup menu for users without a password.

Smart Cover

Allows you to disable cover removal sensor or to notify user if sensor has been activated.

Device Security

Makes the following devices available or unavailable to the system:
●

Serial port

●

All USB ports

●

System audio

●

Network controller

●

Embedded Security Device

For each device, Device Available is the default setting and allows the operating system access
to the device. Device Hidden makes the device unavailable; it is disabled by the BIOS and cannot
be enabled by the operating system. When enabled, Embedded Security Device offers these
options:
●

Embedded Security Device Support

●

Enable/Disable—Turns the TPM on/off. If enabled, these options become available:
◦

Power-On Authentication Support – Enables/disables an authentication feature that
requires you to enter a TPM user key password to boot the system. This feature uses
the TPM to generate and store the authentication password.

◦

Reset Authentication Credential – Resets the authentication functionality and clears all
authentication credentials.

NOTE: A setup password must be set to enable the Embedded Security Device and to access
any security features associated with the Embedded Security Device.
Network Service Enables/disables the ability to boot to the network by way of the F12 key or the boot order.
Boot
System IDs

Asset Tag–a 16–byte string identifying the system.
Ownership Tag–an 80–byte string identifying ownership of the system. This tag is displayed on the
screen during POST.
Universal Unique Identifier (UUID)–can only be updated if the current chassis serial number is
invalid. (These ID numbers are normally set in the factory and are used to uniquely identify the
system.)
Keyboard–enables you to set the keyboard locale for System ID entry.

DriveLock
Security

Allows you to select a hard drive, enable/disable DriveLock security on that drive, and set a
DriveLock password. This option appears only if your drive supports DriveLock.
CAUTION: Enabling DriveLock can render a hard drive permanently inaccessible if the master
password is lost or forgotten. No method exists to recover the password or access the data.

Operating
System Security
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Data Execution Prevention–enables/disables Data Execution Prevention mode in the processors.
This mode prohibits code from running in pages that were set up as data pages, and prevents
attacks such as buffer overflows. Operating system support is required for this feature.
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Table 3-1 Computer Setup (F10) Utility menu descriptions (continued)
Heading

Option

Description
Virtualization Technology – enables Virtualization Technology to increase workstation
performance.
OS Management of Embedded Security Device–enables/disables the ability of the operating
system to control the TPM device. This includes turning it on/off, initializing it, and resetting it.
Reset of Embedded Security Device through OS.–enables/disables the ability of the operating
system to reset the TPM.

Power

Advanced**

ENWW

Setup Security
Level

Enables the administrator to selectively set the security level for each setup feature. The options
are Setup Password and None. Browser mode must be enabled to use this option.

OS Power
Management

Enables/disables:
●

ACPI S3 Hard Disk Reset

●

USB Wake on Device Insertion

●

Unique Sleep State Blink Rates

Thermal

Enables you set the rate of the system fan when processor is in idle.

Power-On
Options

Allows you to set:
●

POST Mode (QuickBoot, FullBoot, or FullBoot every 1–30 days).

●

POST Messages (Enable/Disable).

●

F9 Prompt (Enable/Disable). Enabling this feature displays the text F9=Boot Menu during
POST. Disabling this feature prevents the text from being displayed. However, pressing the
F9 key still accesses the boot menu.

●

F10 Prompt (Enable/Disable). Enabling this feature displays the text F10=Setup during POST.
Disabling this feature prevents the text from being displayed, but pressing F10 still accesses
the Setup screen.

●

F11 Prompt (Enable/Disable). Makes the Factory Recovery option visible during POST.
Disabling this feature prevents the text from being displayed, but pressing F10 still accesses
the Setup screen. Factory Recovery Boot Support must be enabled to use this option.

●

F12 Prompt (Enable/Disable). Enabling this feature displays F12=Network Service Boot
during POST. Disabling this feature prevents the text from being displayed but pressing F12
still forces the system to attempt booting from the network.

●

Factory Recovery Boot Support (Enable/Disable). Recovery partition (HDD) option available.
Vista leaves the factory with this support in place.

●

Option ROM prompt* (Enable/Disable). Enabling this feature causes the system to display a
message before loading options ROMs.

●

Remote Wakeup Boot Source

●

After Power Loss (On/Off); the previous state is the default.

●

POST Delay (in seconds) (Enable/Disable). Enabling this feature adds a user-specified delay
to the POST process. This delay is sometimes needed for hard disks on some PCI cards that
spin up slowly—so slowly that they are not ready to boot by the time POST is finished. The
POST delay also gives you more time to select F10 to enter the Computer Setup (F10) Utility.

●

Limit (CPUID Maximum Value to 3) (Enable/Disable)

Execute
Memory Test

Tests workstation memory. The workstation reboots and any changes that have been made are
lost. The workstation might boot with memory in a sub-optimal configuration.

BIOS Power-On

Enables you to disable or specify a weekday and time for BIOS power-on.

Computer Setup (F10) Utility
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Table 3-1 Computer Setup (F10) Utility menu descriptions (continued)
Heading

Option

Description

Onboard
Devices

Enables you to set resources for or disable onboard system devices such as serial ports and
diskette controllers. Operating system parameters generally override Onboard Devices settings.

Bus Options

The options are:

Device Options

●

PCI SERR# Generation (Enable/Disable)

●

PCI VGA Palette Snooping (Enable/Disable)

●

ECC Support (Enable/Disable)

●

Num Lock State at Power-On (off/on)

●

S5 Wake-on-LAN (Enable/Disable)

●

Processor Cache (Enable/Disable)

●

Internal Speaker (Enable/Disable)

●

Monitor Tracking (Enable/Disable)

●

NIC PxE Option ROM Download (Enable/Disable)

●

SATA RAID Option ROM Download (Enable/Disable)

●

HPET (Enable/Disable)

* Available on selected models.
**These options should be used by advanced users only.

Workstation management
HP Client Management Solutions are available for download from http://www.hp.com/go/easydeploy .
They provide standards-based solutions for managing and controlling workstations in a networked
environment. This section summarizes the capabilities and features of the key components of
workstation management:
●

Initial configuration and deployment

●

Remote system installation

●

Updating and managing software

●

ROM flash

●

Asset tracking and security

●

Fault notification and recovery

NOTE:

Support for specific features described in this guide might vary by model or software version.

Initial configuration and deployment
The workstation comes with a preinstalled system software image. After a brief software unbundling
process, the workstation is ready to use.
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You might prefer to replace the preinstalled software image with a customized set of system and
application software. Several methods are available for deploying a customized software image,
including:
●

Installing additional software applications after unbundling the preinstalled software image

●

Using a disk cloning process to copy the contents from one hard drive to another

The best deployment method depends on your information technology environment and processes. The
PC Deployment section of the HP Lifecycle Solutions Web site (http://whp-sp-orig.extweb.hp.com/
country/us/en/solutions.html) provides information to help you select the best deployment method.
The Restore Plus! CD, ROM-based setup, and ACPI hardware provide further assistance with recovery
of system software, configuration management and troubleshooting, and power management.

Remote system installation
Remote system installation enables you to start and set up your system using the software and
configuration information located on a network server. This feature is usually used as a system setup
and configuration tool and can be used for the following tasks:
●

Deploying a software image on one or more new PCs

●

Formatting a hard drive

●

Installing application software or drivers

●

Updating the operating system, application software, or drivers

To initiate a remote system installation, press when the message appears in the lower-right corner of
the HP logo screen. Follow the onscreen instructions to continue the process. The default boot order is
a BIOS configuration setting that can be changed to always attempt to PXE boot.
HP and Altiris have partnered to provide tools designed to make the task of corporate PC deployment
and management easier and less time-consuming, ultimately lowering the total cost of ownership and
making HP PCs the most manageable client PCs in the enterprise environment.

Replicating the setup
The following procedures enable you to easily copy one setup configuration to other workstations of the
same model for faster, more consistent configuration of multiple workstations.
NOTE:

Both procedures require a diskette drive or a USB device such as an HP Drive Key.

To collect and replicate BIOS settings on multiple computers, use System Software Manager or HP
Client Manager Software. For more information, see: http://www.hp.com/go/easydeploy.

Copying to a single workstation
To copy to a single workstation, complete the following steps:
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CAUTION: A setup configuration is model-specific. File system corruption can result if source and
target workstations are not the same model. For example, do not copy the setup configuration from one
workstation model to another.
1.

Select a setup configuration to copy, and reboot the workstation.

2.

As soon as the boot up process begins, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the utility.

3.

If you are using a diskette or other storage device, insert it now. If not, proceed.

4.

Select File>Replicated Setup>Save to Removable Media. Follow the instructions on the screen
to create the configuration diskette.

5.

Power off the workstation to be configured and insert the configuration diskette.

6.

Power on the workstation to be configured.

7.

Press and hold the F10 key until you enter the Computer Setup (F10) Utility. Press Enter to bypass
the title screen, if necessary.

8.

Select File>Replicated Setup>Restore from Removable Media, and follow the instructions on
the screen.

9.

Restart the workstation when the configuration is complete.

Copying to multiple workstations
CAUTION: A setup configuration is model-specific. File system corruption can result if source and
target workstations are not the same model. For example, do not copy the setup configuration from one
workstation model to another.
This method takes a little longer to prepare the configuration diskette, but copying the configuration to
target workstations is significantly faster. To copy to multiple workstations, complete the following steps:
NOTE: A bootable diskette is required for this procedure. If Windows Vista or Windows XP are not
available to use to create a bootable diskette, use the method for copying to a single workstation instead
(see Copying to a single workstation on page 33).
1.

Create a bootable diskette.

2.

Select a setup configuration to copy.

3.

Restart the workstation.

4.

As soon as the workstation powers on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the utility.

5.

34

If you are using a diskette or other storage device, insert it now.

Chapter 3 System management

ENWW

6.

Select File>Replicated Setup>Save to Removable Media. Follow the instructions on the screen
to create the configuration diskette.

7.

Download a BIOS utility for replicating setup (repset.exe) and copy it onto the configuration diskette.
To obtain this utility, see: http://www.hp.com/support/workstation_swdriversand enter the model
number of the workstation.

8.

On the configuration diskette, create an autoexec.bat file containing: repset.exe
cpqsetup.txt.

9.

Power off the workstation to be configured. Insert the configuration diskette, and power on the
workstation. The configuration utility runs automatically.

10. Restart the workstation when the configuration is complete.

Updating and managing software
HP provides several tools for managing and updating software on desktops and workstations—HP Client
Manager Software, Altiris Client Management Solutions, System Software Manager, Proactive Change
Notification, and Subscriber’s Choice.

HP Client Manager Software
HP Client Manager Software (HP CMS) assists HP customers in managing the hardware aspects of
their client workstations with features that include:
●

Detailed views of hardware inventory for asset management

●

PC health check monitoring and diagnostics

●

Proactive notification of changes in the hardware environment

●

Web-accessible reporting of business-critical details such as machines with thermal warnings,
memory alerts, and more

●

Remote updating of system software such as device drivers and ROM BIOS

●

Remote changing of boot order

●

Configuring the system BIOS settings

For more information on the HP Client Manager, see: http://www.hp.com/go/ssm.
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Altiris Client Management Solutions
HP and Altiris have partnered to provide comprehensive, tightly integrated systems management
solutions to reduce the cost of owning HP client PCs. HP Client Manager Software is the foundation for
additional Altiris Client Management Solutions that address:
●

●

●

●

Inventory and asset management
◦

Software license compliance

◦

PC tracking and reporting

◦

Lease contract and fixing asset tracking

Deployment and migration
◦

Microsoft Windows Vista Business

◦

Microsoft Windows XP Professional or Home Edition migration

◦

System deployment

◦

Personality migrations

Help desk and problem resolution
◦

Managing help desk tickets

◦

Remote troubleshooting

◦

Remote problem resolution

◦

Client disaster recovery

Software and operations management
◦

Ongoing workstation management

◦

HP system software deployment

◦

Application self-healing

See http://www.hp.com/go/ssm for more information about:
●

How HP Client Manager Software works

●

Which solutions are compatible with your operating system

●

How to download a fully-functional, 30-day evaluation version of the Altiris solutions

System Software Manager
System Software Manager (SSM) is a utility that enables you to update system-level software on multiple
systems simultaneously. When executed on a PC client system, SSM detects both hardware and
software versions, and then updates the appropriate software from a central repository, also known as
a file store. Driver versions that are supported by SSM are denoted with a special icon on the software,
the driver download Web site, and on the Support Software CD. To download the utility or to obtain more
information on SSM, see: http://www.hp.com/go/ssm.

36

Chapter 3 System management

ENWW

Proactive Change Notification
The Proactive Change Notification program uses the Subscriber's Choice Web site to proactively and
automatically:
●

Send you Proactive Change Notification (PCN) emails informing you of hardware and software
changes to most commercial workstations and servers, up to 60 days in advance

●

Send you emails containing customer bulletins, customer advisories, customer notes, bulletins,
and driver alerts for most commercial workstations and servers

Subscriber’s Choice
Subscriber’s Choice is a client-based service from HP. Based on your profile, HP will supply you with
personalized product tips, feature articles, and driver and support alerts and notifications. Subscriber’s
Choice Driver and Support Alerts/Notifications will deliver emails notifying you that the information you
subscribed to in your profile is available for review and retrieval. To learn more about Subscriber’s
Choice and create a custom profile, see: http://www.hp.com/go/subscriberschoice.

ROM Flash
The workstation comes with a programmable flash ROM. By establishing a setup password in the
Computer Setup (F10) Utility, you can protect the ROM from being unintentionally updated or
overwritten. This is important to ensure the operating integrity of the workstation. To upgrade the ROM,
download the latest SoftPaq images from http://www.hp.com/support/workstation_swdrivers.
NOTE: For maximum ROM protection, be sure to establish a setup password. The setup password
prevents unauthorized ROM upgrades. System Software Manager enables you to set the setup
password on one or more PCs simultaneously. For more information, see: http://www.hp.com/go/ssm.

Remote ROM Flash
Remote ROM Flash allows the system administrator to safely upgrade the ROM on remote HP
workstations directly from the centralized network management console, resulting in a consistent
deployment of and greater control over HP PC ROM images over the network. It also results in greater
productivity and lower total cost of ownership.
The workstation must be powered on, or turned on through Remote Wakeup, to use Remote ROM Flash.
For more information on Remote ROM Flash, see the HP Client Manager Software or System Software
Manager sections at http://www.hp.com/go/ssm.

HPQFlash
The HPQFlash utility is used to locally update or restore the system ROM on individual PCs through a
Windows operating system.
For more information on HPQFlash, see: http://www.hp.com/go/ssm and enter the name of the
workstation when prompted.

The FailSafe Boot Block ROM
The FailSafe Boot Block ROM is a flash-protected section of the workstation ROM that checks for a
valid system ROM flash image whenever power is applied to the workstation. This protected section of
ROM allows the workstation to recover following an unlikely ROM flash failure (such that as caused by
a workstation power loss) during a ROM upgrade.
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When power is applied to the workstation, the FailSafe Boot Block ROM performs a validation of the
system ROM, and:
●

If the system ROM is valid, the workstation starts normally.

●

If the system ROM fails the validation, the FailSafe Boot Block ROM provides enough support to
start the workstation from a BIOS CD or USB storage media image created from a SoftPaq. To
accomplish this recovery, the CD or USB media BIOS image programs the system ROM with a
valid flash image.

When power is applied to the workstation and the FailSafe Boot Block validation detects an invalid
system ROM image, the workstation power LED blinks red eight times with a simultaneous audible beep.
The workstation then looks for CD or USB media that contains a valid flash image. If no valid recovery
image is found, a Boot Block recovery mode message to that effect is sent to the display. If a valid
recovery media and flash image are found, the workstation flashes the system ROM with the valid image
and a message to that effect is also sent to the display.
Preparing for validation failure recovery—In preparation for workstation system recovery, use the
BIOS CD media file in the SoftPaq to create a BIOS image CD as a recovery backup. You can also use
USB media such as an HP DriveKey as the BIOS image recovery media.
To create a BIOS image for recovery backup, see: http://www.hp.com/support/workstation_swdrivers
Recovering from a boot block validation failure—To recover the system ROM after it enters Boot
Block recovery mode:
1.

Remove all diskette and CD media from workstation drives.

2.

Insert a BIOS image recovery CD or USB storage media (such as an HP DriveKey) into the
appropriate drive or connector.

3.

Power off, then power on the workstation.
If no BIOS image CD or USB media is found after the simultaneous eight red LED flashs and beeps,
you are prompted to insert one and to restart the workstation. When a valid recovery image is found,
the system ROM will flash that image.
NOTE: During system ROM recovery, the system ROM will flash without asking for a setup or
power on password. However, following a successful recovery flash and workstation reboot,
previously set passwords will remain active and are required.

4.

Remove the recovery CD or USB media and power off the system.

5.

Restart the workstation and resume normal operation.

Asset tracking and security
Asset tracking features incorporated into the workstation provide key asset tracking data that can be
managed using HP Systems Insight Manager, HP Client Manager Software, or other system
management applications. Seamless, automatic integration between asset tracking features and these
products enables you to choose the management tool that is best suited to the environment and to
leverage the investment in existing tools.
HP also offers several solutions for controlling access to valuable components and information.
ProtectTools Embedded Security, if installed, prevents unauthorized access to data and checks system
integrity and authenticates third-party users attempting system access. Security features such as
ProtectTools and the optional Hood Sensor (Smart Cover Sensor) help prevent unauthorized access to
your data and to the internal components of the workstation. By disabling serial or USB ports or by
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disabling removable media boot capability, you can protect valuable data assets. Memory Change and
Hood Sensor (Smart Cover Sensor) alerts can be automatically forwarded to system management
applications to deliver proactive notification of tampering with a workstation’s internal components.
NOTE: ProtectTools, the Hood Sensor (Smart Cover Sensor), and the Hood Lock (Smart Cover Lock)
are available as options on select systems.
Use the following utilities to manage security settings on the HP workstation:
●

Locally, using the Computer Setup (F10) Utility.

●

Remotely, using HP Client Manager Software or System Software Manager. This software enables
the secure, consistent deployment and control of security settings from a simple command line
utility.

The following table and sections refer to managing security features of the workstation locally through
the Computer Setup (F10) Utility.
Table 3-2 Security Features Overview
Feature

Purpose

How it is established

Removable Media Boot Control

Prevents booting from the removable media
drives.

From the Computer Setup (F10)
Utility menu.

Serial, USB, or Infrared
Interface Control

Prevents transfer of data through the
integrated serial, USB, or infrared interface.

From the Computer Setup (F10)
Utility menu.

Power-On Password

Prevents use of the workstation until the
password is entered. This can apply to both
initial system startup and restarts.

From the Computer Setup (F10)
Utility menu.

Setup Password

Prevents reconfiguration of the workstation
(use of the Setup Utilities) until the password
is entered.

From the Computer Setup (F10)
Utility menu.

Network Server Mode

Provides unique security features for
workstations being used as servers.

From the Computer Setup (F10)
Utility menu.

NOTE: For more information about the Computer Setup (F10) Utility, see Computer Setup (F10) Utility menu on page 27.

Password security
The power-on password prevents unauthorized use of the workstation by requiring entry of a password
to access applications or data each time the workstation is powered on or restarted. The setup password
specifically prevents unauthorized access to the Computer Setup (F10) Utility and can also be used as
an override to the power-on password. That is, when prompted for the power-on password, entering the
setup password instead will enable access to the workstation.
You can establish a network-wide setup password to enable the system administrator to log in to all
network systems to perform maintenance without having to know the power-on password.
NOTE: System Software Manager and HP Client Manager Software enable remote management of
Setup Passwords and other BIOS settings in a networked environment. For more information, see:
http://www.hp.com/go/easydeploy.
Establishing a setup password using the Computer Setup (F10) Utility
Establishing a setup password through the Computer Setup (F10) Utility prevents reconfiguration of the
workstation (via use of the Computer Setup (F10) Utility) until the password is entered.
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To establish a setup password using workstation setup:
1.

Power on or restart the workstation.

2.

As soon as the computer is powered on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the utility.

3.

Select Security>Setup Password and follow the onscreen instructions.

4.

Before exiting, select File>Save Changes and Exit.

Establishing a power-on password using workstation setup
Establishing a power-on password through the Computer Setup (F10) Utility prevents access to the
workstation when power is connected, unless the password is entered. When a power-on password is
set, the Computer Setup (F10) Utility presents Password Options under the Security menu. The
password options include Network Server Mode and Password Prompt on Warm Boot.
When Network Server Mode is disabled, the password must be entered each time the workstation is
powered on when the key icon appears on the monitor When Password Prompt on Warm Boot
is enabled, the password must also be entered each time the workstation is rebooted. When Network
Server Mode is enabled, the password prompt is not presented during POST.
To enable Network Server Mode, a power-on password must be set. The option is available under
Advanced>Password Options. This option enables the system to boot without asking for the poweron password, but the keyboard and mouse are locked until you enter it. The keyboard LEDs rotate
constantly when the system is in locked mode.
To establish a power-on password through workstation setup:
1.

Power on or restart the workstation.

2.

As soon as the computer is powered on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the utility.

3.

Select Security>Power-On Password and follow the onscreen instructions.

4.

Before exiting, select File>Save Changes and Exit.

Entering a power-on password
1.

Restart the workstation.

2.

When the key icon appears on the monitor, enter the current password, and press Enter.

NOTE:

Type carefully. For security reasons, the characters you enter do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful
tries, you must restart the workstation before you can continue.
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Entering a Setup Password
If a setup password has been established on the workstation, you will be prompted to enter it each time
you run the Computer Setup (F10) Utility.
To enter a setup password:
1.

Restart the workstation.

2.

As soon as the workstation is powered on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the utility.

3.

When the key icon appears on the monitor, enter the setup password, and press Enter.

NOTE:

Type carefully. For security reasons, the characters you enter do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful
tries, you must restart the workstation before you can continue.
Changing a power-on or setup password
1.

Restart the workstation.

2.

To change the Setup password, as soon as the workstation is turned on, press and hold the F10
key until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if
necessary.
NOTE: If you do not press F10 at the appropriate time, you must restart the workstation and press
and hold the F10 key again to access the utility.

3.

When the key icon appears, enter the current password, a slash (/) or alternate delimiter character,
your new password, another slash (/) or alternate delimiter character, and your new password again
as shown: current password/new password/new password
NOTE: Type carefully. For security reasons, the characters you enter do not appear on the
screen.

4.

Press Enter.

The new password takes effect the next time you power on the workstation.
NOTE: Refer to National keyboard delimiter characters on page 42 for information about the
alternate delimiter characters. The power-on password and setup password can also be changed using
the Security options in the Computer Setup (F10) Utility.
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Deleting a power-on or setup password
1.

Power on or restart the workstation.

2.

To delete the power-on password, go to step 3.
To delete the Setup Password, as soon as the workstation is powered on, press and hold the
F10 key until you enter the Computer Setup (F10) Utility. Press Enter to bypass the title screen, if
necessary.
NOTE: If you do not press the F10 key at the appropriate time, you must restart the computer
and press and hold the F10 key again to access the utility.
Use the appropriate operating system shutdown process. To delete the setup password, run the
Computer Setup (F10) Utility.

3.

When the key icon appears, enter your current password followed by a slash (/) or alternate
delimiter character as shown: current password/

4.

Press Enter.

NOTE: Refer to National keyboard delimiter characters on page 42 for information about the
alternate delimiter characters. The power-on password and setup password can also be changed using
the Security options in the Computer Setup (F10) Utility.
National keyboard delimiter characters
Each keyboard is designed to meet country-specific requirements. The syntax and keys that you use
for changing or deleting your password depend on the keyboard that came with your workstation.
Table 3-3 National keyboard delimiter characters
Language

Delimiter

Language

Delimiter

Language

Delimiter

Arabic

/

Greek

-

Russian

/

Belgian

=

Hebrew

.

Slovakian

-

BHCSY*

-

Hungarian

-

Spanish

-

Brazilian

/

Italian

-

Swedish/Finnish

/

Chinese

/

Japanese

/

Swiss

-

Czech

-

Korean

/

Taiwanese

/

Danish

-

Latin American

-

Thai

/

French

!

Norwegian

-

Turkish

.

French
Canadian

é

Polish

-

U.K. English

/

German

-

Portuguese

-

U.S. English

/

NOTE: * For Bosnia-Herzegovina, Croatia, Slovenia, and Yugoslavia.

Clearing passwords
If you forget your password, you cannot access the workstation. Refer to the section on resetting the
password jumper for instructions on clearing passwords.

42

Chapter 3 System management

ENWW

The DriveLock security feature
CAUTION: The DriveLock security feature can render a hard drive permanently inaccessible if the
master password is lost or forgotten. No method exists to recover the password or access the data.
DriveLock uses an industry-standard security feature that prevents unauthorized access to the data on
an ATA hard drive. DriveLock has been implemented as an extension to the Computer Setup (F10)
Utility functions. It is only available when hard drives that support the ATA security command set are
detected. On HP workstations, it is not available when the SATA emulation mode is RAID+AHCI or
RAID.
DriveLock is intended for HP customers for whom data security is a paramount concern. For such
customers, the cost of a hard drive and the loss of the data stored on it is inconsequential when compared
to the damage that could result from unauthorized access to its contents.
In order to balance this level of security with the practical need to address the issue of a forgotten
password, the HP implementation of DriveLock employs a two-password security scheme. One
password is intended to be set and used by a system administrator, while the other is typically set and
used by the end-user. There is no "back door" that can be used to unlock the drive if both passwords
are lost. Therefore, DriveLock is most safely used when the data contained on the hard drive is replicated
on a corporate information system or is regularly backed up. In the event that both DriveLock passwords
are lost, the hard drive is rendered unusable. For users who do not fit the previously defined customer
profile, this may be an unacceptable risk. For users who do fit this profile, it may be a tolerable risk,
given the nature of the data stored on the hard drive.
DriveLock applications
The most practical use of the DriveLock security feature is in a corporate environment. The system
administrator would be responsible for configuring the hard drive, which involves setting the DriveLock
master password and a temporary user password. In the event that the user forgets the user password
or the equipment is passed on to another employee, the master password can always be used to reset
the user password and regain access to the hard drive.
HP recommends that corporate system administrators who choose to enable DriveLock also establish
a corporate policy for setting and maintaining master passwords. This should be done to prevent a
situation where an employee intentionally or unintentionally sets both DriveLock passwords before
leaving the company. In such a scenario, the hard drive is rendered unusable and requires replacement.
Likewise, by not setting a master password, system administrators might find themselves locked out of
a hard drive and unable to perform routine checks for unauthorized software, other asset control
functions, and support.
For users with less stringent security requirements, HP does not recommend enabling DriveLock. Users
in this category include personal users, or users who do not maintain sensitive data on their hard drives
as a common practice. For these users, the potential loss of a hard drive resulting from forgetting both
passwords is much greater than the value of the data DriveLock has been designed to protect.
Access to the Computer Setup (F10) Utility and DriveLock can be restricted through the setup password.
By specifying a setup password and not giving it to end users, system administrators are able to restrict
users from enabling DriveLock.
Using DriveLock
When one or more hard drives that support the ATA security command set are detected, the DriveLock
option appears under the Security menu in the Computer Setup (F10) Utility. You are presented with
options to set the master password and to enable DriveLock. A user password must be provided to
enable DriveLock. Since the initial configuration of DriveLock is typically performed by a system
administrator, a master password should be set first. HP encourages system administrators to set a
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master password whether they plan to enable DriveLock or not. This gives the administrator the ability
to modify DriveLock settings if the drive is locked in the future. Once the master password is set, the
system administrator might enable DriveLock or choose to leave it disabled.
If a locked hard drive is present, POST requires a password to unlock the device. If a power-on password
is set and it matches the device’s user password, POST does not prompt the user to re-enter the
password. Otherwise, the user is prompted to enter a DriveLock password. For a cold-boot, use the
master or user password. For a warm-boot, you must enter the same password used to unlock the drive
during the preceding cold-boot. Users are given two attempts to enter a correct password. During coldboot, if neither attempt succeeds, POST continues but the drive remains inaccessible. During a warmboot or restart from Windows, if neither attempt succeeds, POST halts and the user is instructed to cycle
power.
To enable and set the DriveLock user password:
1.

Power on or restart the workstation.

2.

As soon as the workstation is powered on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation,
and then press and hold the F10 key again to access the utility.

3.

Select Security>DriveLock Security.

4.

For each DriveLock-capable drive, select a drive by pressing the F10 key to accept.

5.

Under Enable/Disable DriveLock options, select Enable, and then press the F10 key to enable
DriveLock for a particular drive.
CAUTION:

Forgetting the DriveLock password renders the drive unusable.

6.

Enter a new user password, and then press the F10 key to accept. This password can contain
anywhere from one to 32 characters.

7.

Enter the password again in the Enter New Password Again field. If you forget this password, the
drive is rendered permanently disabled.

8.

Select File>Save Changes and Exit, and then press the F10 key. After you press the F10 key,
the system performs a cold-boot before invoking the DriveLock function.

NOTE: This process can also be used to set the DriveLock master password by selecting Master in
Step 5.
When the workstation starts, you are prompted to enter the DriveLock password for each DriveLockcapable drive for which you have previously set a password. You are given two attempts to enter the
password correctly. If the password is not entered correctly, the workstation attempts to boot anyway.
However, the boot process most likely fails because data from a locked drive cannot be accessed.
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You can configure your workstation to boot either with or without DriveLock enabled for the boot drive
as follows:
●

In a single drive workstation, if the drive is DriveLock enabled, the workstation might not be able
to boot to the operating system, and might try to boot from the network or from another storage
device instead (depending on the boot ordering options). Regardless of the outcome of the boot
attempts, the drive-locked drive remains inaccessible without the DriveLock password.

●

In a two-drive workstation that has a boot drive and a data drive, you can apply the DriveLock
feature to the data drive only. In this case, the workstation can always boot without the DriveLock
password, but the data drive is accessible only when the DriveLock password is entered.

Cold-boots require that you enter DriveLock passwords. However, DriveLock passwords are also
required for warm-boots. For example, if you boot to DOS and enter Ctrl-Alt-Del, you must enter the
DriveLock password before the workstation completes the next boot cycle. This warm-boot behavior is
consistent with the DriveLock feature.

Hood sensor option (smart cover sensor)
The optional hood sensor is a combination of hardware and software technology that can alert you when
the workstation side access panel has been removed if the sensor has been properly configured in the
Computer Setup (F10) Utility. There are three levels of protection, as described in the following table.
Table 3-4 Hood Sensor Protection Levels
Level

Setting

Description

Level 0

Disabled

Hood sensor is disabled (default).

Level 1

Notify User

When the workstation restarts, the screen displays a message indicating that the
workstation side access panel has been removed.

Level 2

Setup Password

When the workstation is restarted, the screen displays a message indicating that
the workstation side access panel has been removed. You must enter the setup
password to continue.

These settings can be changed using the Computer Setup (F10) Utility.

Setting the hood sensor protection level
1.

Power on or restart the workstation.

2.

As soon as the workstation is powered on, press and hold the F10 key until you enter the Computer
Setup (F10) Utility. Press Enter to bypass the title screen, if necessary.
NOTE: If you do not press the F10 key at the appropriate time, you must restart the computer
and press and hold the F10 key again to access the utility.

3.

Select Security>Smart Cover>Cover Removal Sensor, and follow the onscreen instructions.

4.

Before exiting, select File>Save Changes and Exit.

Hood lock (smart cover lock)
The hood lock is a solenoid that secures the workstation access cover to the chassis. It is controlled by
a password in the BIOS. When installed, the hood lock can prevent unauthorized access to the internal
components.
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CAUTION: For maximum cover lock security, be sure to establish a setup password. The setup
password prevents unauthorized access to the Computer Setup (F10) Utility.
Locking the solenoid lock
1.

Power on or restart the workstation.

2.

As soon as the workstation is powered on, press and hold the F10 key until you enter Computer
Setup. Press Enter to bypass the title screen, if necessary.
NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the utility.
If you are using a PS2 keyboard, you might see a Keyboard Error message—disregard it.

3.

Select Security>Smart Cover>Cover Lock>Lock.

4.

Select Fire>Save Changes and Exit.

Unlocking the solenoid lock
1.

Power on or restart the workstation.

2.

As soon as the workstation is powered on, press and hold the F10 key until you enter Computer
Setup. Press Enter to bypass the title screen, if necessary.
NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the utility.
If you are using a PS2 keyboard, you might see a Keyboard Error message—disregard it.

3.

Select Security>Smart Cover>Cover Lock>Unlock.

4.

Select Fire>Save Changes and Exit.

Using a FailSafe key
If you enable the hood lock, your will need a FailSafe Key in order to open the workstation side access
panel under the following conditions:
●

Power outage

●

Startup failure

●

PC component failure (such as processor or power supply)

●

Forgotten password

NOTE: The FailSafe Key is a workstation accessory that must be ordered from HP. Be prepared; order
this key before you actually need it.
You can order a FailSafe Key in either of the two following key configurations:
●

Smart Cover FailSafe Key, tamper-resistant T-15 wrench

●

Smart Cover FailSafe Key, tamper-resistant screwdriver bit.

To determine the correct HP part number for each key configuration, see http://partsurfer.hp.com.
To obtain the FailSafe Key, contact HP post sales support by telephone or online:
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●

HP post sales support telephone: 1-800–hp-invent

●

HP post sales support Web site: http://welcome.hp.com/country/us/en/wwcontact_us.html.

Clearing Passwords
If you forget your password, you cannot access the workstation. Refer to the section on resetting the
password jumper in the appendix.

Cable lock provision (optional)
The rear panel of the chassis can accommodate a cable lock accessory that allows the workstation to
be physically secured to a work area.

Security lock (optional)
The security lock prevents entire system theft and discourages access panel removal.

Hood lock (Smart cover lock) (optional)
Prevents removal of the access panel and all internal components including optical and diskette drives.
This lock eliminates the need for a physical key by enabling password-protected locking and locking by
a local or a remote user.

Hood sensor (Smart cover sensor) (optional)
This sensor is set in the Computer Setup (F10) Utility. You can set this to notify a user if the access
panel has been removed.

Fault notification and recovery
Fault notification and recovery features combine innovative hardware and software technology to
prevent the loss of critical data and minimize unplanned downtime
If the workstation is connected to a network managed by HP Client Manager Software, the computer
sends a fault notice to the network management application. With HP Client Manager Software, you can
also remotely schedule diagnostics to automatically run on all managed PCs and create a summary
report of failed tests.

Drive Protection System
The Drive Protection System (DPS) is a diagnostic tool built into the hard drives that is installed in select
HP workstations. the DPS is designed to help diagnose problems that might result in unwarranted hard
drive replacement.
When HP workstations are built, each installed hard drive is tested using the DPS, and a permanent
record of key information is written onto the drive. Each time the DPS is run, test results are written to
the hard drive. The service provider can use this information to help diagnose conditions that caused
you to run the DPS software.

ECC fault prediction and prefailure warranty
When the workstation encounters an excessive number of error checking and correcting (ECC) memory
errors, the workstation displays a Local Alert message. This message contains detailed information
about the errant memory module, enabling you to take action before you experience non-correctable
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memory errors. The Prefailure Warranty for ECC memory modules enables you to replace these
modules, free of charge, before the modules actually fail. ECC memory modules are optional on selected
HP workstations.

Thermal sensor
There are multiple sensors on your workstation:
●

One for the processor

●

One for the system board

●

Some hard drives

The processor thermal sensor monitors the processor core temperature, while the board thermal sensor
monitors the internal temperature of the workstation. These sensors control the speed of the workstation
cooling fans as the processor and internal workstation temperatures increase and decrease.
The cooling system is designed to provide maximum thermal dissipation for a fully configured
workstation, which ensures that the processor and all system components do not exceed safe operating
temperatures. If the maximum force of the cooling fans cannot adequately cool the processor, the
processor clock automatically begins to slow. If the temperature remains above limits even with reduced
processor clock speed, the system eventually shuts down.

Dual-State Power Button
With ACPI enabled, the power button can function either as an on/off switch or as a button. The feature
does not completely turn off power, but instead causes the workstation to enter a low-power standby
state. This allows you to power down without closing applications and to return to the same operational
state without any data loss.
To change the power button configuration:
1.

Select Start, and select Control Panel>Power Options.

2.

In Power Options Properties, select the Advanced tab.

3.

In the Power Button section, select Hibernate. (Hibernate must be enabled in the Hibernate
tab.)

After configuring the power button to function as a button, press the power button to put the system in
a very low power state. Press the button again to bring the system out of the very low power state to full
power status. To completely turn off all power to the system, press and hold the power button for four
seconds.
CAUTION: Do not use the power button to power off the workstation unless the system is not
responding; turning off the power without operating system interaction could cause damage to or loss
of data on the hard drive.

48

Chapter 3 System management

ENWW

4

Removal and replacement procedures

This chapter describes removal and replacement procedures of most internal components of the
workstation, and includes the following sections:
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●

Warnings and cautions on page 50

●

Service considerations on page 52

●

Customer Self-Repair on page 56

●

Predisassembly procedures on page 57

●

System board components on page 58

●

Steps for removing and replacing components on page 60

●

Product recycling on page 99
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Warnings and cautions
WARNING!
Any surface or area of the equipment marked with these symbols indicates the
presence of a hot surface or hot component. If this surface is contacted, the potential for injury exists.
To reduce the risk of injury from a hot component, allow the surface to cool before touching.
WARNING!
Any surface or area of the equipment marked with these symbols indicates the
presence of an electrical shock hazard. To reduce the risk of injury from electrical shock, do not open
any enclosed area.
WARNING! To reduce the risk of electric shock or damage to your equipment:
— Do not disable the power cord grounding plug. The grounding plug is an important safety feature.
— Plug the power cord in a grounded (earthed) outlet that is easily accessible at all times.
— Disconnect power from the equipment by unplugging the power cord from the electrical outlet.
WARNING! To reduce the risk of serious injury, read the Safety & Comfort Guide. It describes proper
workstation, setup, posture, and health and work habits for computer users, and provides important
electrical and mechanical safety information. This guide is located on the Web at http://www.hp.com/
ergo and/or on the documentation CD if one is included with the product.

WARNING! If a product is shipped in packaging marked with this symbol,
always be lifted by two persons to avoid personal injury due to product weight.

, the product must

CAUTION: Static electricity can damage the electronic components of the workstation. Before
beginning these procedures, be sure you are discharged of static electricity by briefly touching a
grounded metal object.
CAUTION: Observe the following cautions when removing or replacing a processor:
— Installing a processor incorrectly can damage the system board. Have an HP authorized reseller or
service provider install the processor. If you plan to install it yourself, read all of the instructions carefully
before you begin.
— Failure to follow the workstation preparation instructions and these result in an improperly installed
processor, causing extensive system damage.
— Processor socket pins are delicate and bend easily. Use extreme care when placing the processor
in the socket.
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CAUTION: To prevent damage to this system, observe the following Electro Static Discharge (ESD)
precautions while performing the system parts removal/replacement procedures:
— Work on a static-free mat.
— Wear a static strap to ensure that any accumulated electrostatic charge is discharged from your body
to the ground.
— Create a common ground for the equipment you are working on by connecting the static-free mat,
static strap and peripheral units to that piece of equipment.
NOTE: HP accessories are for use in HP workstation products. They have been extensively tested for
reliability and are manufactured to high quality standards. HP, therefore, warrants only those
accessories that are manufactured or sold by HP.
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Service considerations
The following sections discuss service considerations that should be reviewed and practiced before
removing and replacing any system components.
WARNING! When lifting or moving the workstation, do not use the front bezel as a handle or lifting
point. Lifting the workstation from the front bezel or lifting it incorrectly can cause the unit to fall and harm
you and damage the workstation. To properly and safely lift the workstation, lift it from the bottom of the
unit.

Cautions, warnings, and safety precautions
For your safety, review the cautions, warnings, and safety precautions before accessing the workstation
components. Also, review the Safety and Regulatory Guide that came with your workstation for more
information.

Electrostatic discharge information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic
device exposed to electrostatic discharge (ESD) might not appear to be affected at all and can function
normally for a while, but it has been degraded in the internal layers, reducing its life expectancy.
Networks built into many integrated circuits provide some protection, but in many cases, the discharge
contains enough power to alter device parameters or melt silicon junctions.

Generating static electricity
The following table shows that different activities generate different amounts of static electricity. Static
electricity increases as humidity decreases.
Table 4-1 Static electricity
Relative humidity
55%

Event

40%

10%

Walking across carpet

7,500V

15,000V

35,000V

Walking across vinyl floor

3,000V

5,000V

12,000V

Motions of bench worker

400V

800V

6,000V

Removing bubble pack from PCB

7,000V

20,000V

26,500V

Packing PCBs in foam-lined box

5,000V

11,000V

21,000V

NOTE: 700 volts can degrade a product.
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Preventing electrostatic damage to equipment
Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree
of sensitivity. The following packaging and grounding precautions are necessary to prevent damage to
electric components and accessories.
●

Transport products in static-safe containers, such as tubes, bags, or boxes, to avoid hand contact.

●

Protect all electrostatic parts and assemblies with approved non-conductive containers or
packaging.

●

Keep electrostatic-sensitive parts in their containers until they arrive at static-free stations.

●

Place items on a grounded surface before removing them from their containers.

●

When handling or touching a sensitive component or assembly, ground yourself by touching the
chassis.

●

Avoid contact with pins, leads, or circuitry.

●

Place reusable electrostatic-sensitive parts from assemblies in protective packaging or nonconductive foam.

Personal grounding methods and equipment
Use the following equipment to prevent static electricity damage to equipment:
●

Wrist straps are flexible straps with a maximum of one megohm ± 10% resistance in the ground
cords. To provide a proper ground, wear the strap against bare skin. The ground cord must be
connected and fit snugly into the banana plug connector on the grounding mat or workstation.

●

Heel straps, toe straps, and boot straps can be used at standing workstations and are compatible
with most types of shoes or boots. On conductive floors or dissipative floor mats, use them on both
feet with a maximum of one-megohm ± 10% resistance between the operator and ground.

Table 4-2 Static shielding protection levels
Method

Voltage

Antistatic plastic

1,500

Carbon-loaded plastic

7,500

Metallized laminate

15,000

Grounding the work area
To prevent static damage at the work area:
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●

Cover the work surface with approved static-dissipative material. Provide a wrist strap connected
to the work surface and properly grounded tools and equipment.

●

Use static-dissipative mats, foot straps, or air ionizers to give added protection.

●

Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only at static-free work areas.

●

Disconnect power and input signals before inserting and removing connectors or test equipment
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●

Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.

●

Keep work area free of non-conductive materials, such as ordinary plastic assembly aids and
Styrofoam.

●

Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended materials and equipment
Materials and equipment that are recommended for use in preventing static electricity include:
●

Antistatic tape

●

Antistatic smocks, aprons, or sleeve protectors

●

Conductive bins and other assembly or soldering aids

●

Conductive foam

●

Conductive tabletop workstations with ground cord of one-megohm ± 10% resistance

●

Static-dissipative table or floor mats with hard tie to ground

●

Field service kits

●

Static awareness labels

●

Wrist straps and footwear straps providing one-megohm ± 10% resistance

●

Material handling packages

●

Conductive plastic bags

●

Conductive plastic tubes

●

Conductive tote boxes

●

Opaque shielding bags

●

Transparent metallized shielding bags

●

Transparent shielding tubes

Tools and software requirements
●

Torx T-15 screwdriver or flatblade screwdriver

●

Phillips screwdriver

●

Diagnostics software

Screws
The screws used in the workstation are not interchangeable. They might have standard or metric threads
and might be of different lengths. If an incorrect screw is used during the reassembly process, it can
damage the unit. Hewlett-Packard strongly recommends that all screws removed during disassembly
be kept with the removed part, and then returned to their proper locations.
NOTE: Metric screws have a black finish. American National Standards Institute (ANSI) screws have
a silver finish.
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As each subassembly is removed from the workstation, place the subassembly away from the work
area to prevent damage.
If necessary, additional drive guide screws are provided on the system chassis. There are eight Metric
screws (1), as shown in the following figure, located on the chassis near the 5.25-inch optical drive bays.
These screws can be used to mount additional optical drives or an optional diskette drive. There are
four ANSI screws (2), as shown in the following figure, located on the chassis near the hard drive. These
screws can be used to mount additional hard drives in the 3.5” hard drive cage.
NOTE:

Metric (black) and ANSI (silver) screws are not interchangeable.

Figure 4-1 Metric and ANSI screw identification

Metric screws
1
NOTE:
drives.
2

Used for optical and diskette

ANSI screws
NOTE:

Used for hard drives.

Special handling of components
The following components require special handling when servicing the workstation.
WARNING! Do not use the front bezel as a handle or lifting point when lifting or moving the workstation.
Lifting the workstation from the front bezel or lifting it incorrectly could cause the unit to fall and cause
harm to the user and damage to the workstation. To properly and safely lift the workstation, lift it from
the bottom of the chassis for either the desktop or minitower configuration.

Cables and connectors
Cables must be handled with care to avoid damage. Apply only the tension required to seat or unseat
the cables during insertion or removal from the connector. Handle cables by the connector or pull strap

ENWW

Service considerations

55

whenever possible. In all cases, avoid bending or twisting the cables, and ensure that the cables are
routed in such a way that they cannot be caught or snagged by parts being removed or replaced.
CAUTION: When servicing this workstation, be sure that cables are placed in their proper location
during the reassembly process. Improper cable placement can damage the workstation.

Hard drives
Handle hard drives as delicate, precision components, and avoid all physical shock and vibration. This
guideline applies to failed drives as well as replacement spares.
●

If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “Fragile: Handle With Care.”

●

Do not remove new or replacement hard drives from the shipping package for storage. Keep hard
drives in their protective packaging until they are actually mounted in the workstation.

●

Avoid dropping drives from any height onto any surface.

●

Power off the workstation before removing a hard drive. Do not remove a hard drive while the
workstation is on or in standby mode.

●

Ensure that you are discharged of static electricity before handling a drive. While handling a drive,
avoid touching the data connector.
CAUTION: To prevent possible damage from static electricity from in the drive being installed,
always connect the drive power cable before connecting the data cable. This will discharge any
accumulated static electricity through the drive power cable to the workstation chassis.
For more information about preventing electrostatic damage, see Electrostatic discharge
information on page 52.

●

Do not use excessive force when inserting a drive.

●

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

Lithium coin cell battery
The workstation battery provides power to the real-time clock and has a minimum lifetime of
approximately three years.
For instructions on battery removal and replacement, see the Battery on page 81 section of this
chapter.
WARNING! This workstation contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose of
in water or fire, or expose it to temperatures higher than 140° Fahrenheit (60° Centigrade).
NOTE:
waste.

Batteries, battery packs, and accumulators should not be disposed of with general household

Customer Self-Repair
Customer Self-Repair enables you to obtain replacement parts and install them yourself on your
workstation. See http://www.hp.com/go/selfrepair for more information.
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Predisassembly procedures
Perform the following steps before servicing the workstation:

ENWW

1.

Close any open software applications.

2.

Remove any diskettes or CDs from the workstation.

3.

Shut down the operating system.

4.

Power off the workstation and any peripheral devices that are connected to it.

5.

Remove or disengage any security devices that prohibit opening the workstation.

6.

Disconnect the power cord from the electrical outlet and from the workstation.

7.

Disconnect all peripheral device cables from the workstation.
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57

System board components
The following illustration shows the system board connectors, sockets, and important switches for the
HP xw4550 Workstation.
Figure 4-2 System board component identification

NOTE:

In the following table, component names are shown as they appear on the system board.

Table 4-3 System board components
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No.

Component

No.

1

COM2 (second) serial
port adapter

12

2

SYS_FAN (rear
chassis fan) connector

3

Component

No.

Component

CONTROL PANEL
(Front control panel)
connector

23

SLOT1_PCIE (PCIexpress) x16 card slot

13

Password Enable
jumper

24

Hood Lock (solenoid
hood lock) connector

Graphics card power
connector

14

Clear CMOS switch

25

Network and USB
connectors

4

CPU (processor )

15

FRONT USB connector

26

USB connectors

5

CPU_FAN (processor
fan) connector

16

Battery

27

Audio connector
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Table 4-3 System board components (continued)
No.

ENWW

Component

No.

Component

No.

Component

6

Memory module
sockets

17

INTERNAL USB
connector

28

DVI-D integrated video
connector

7

Floppy (diskette) drive
connector

18

SPK (speaker)
connector

29

Serial port (top)
connector

8

Power Connector P1
(main power to sysetm
board)

19

FRONT AUDIO
connector

30

VGA (bottom)
connector

9

HOOD SENSE
(optional chassis
intrusion switch)
connector

20

AUX_IN (auxiliary)
audio connector

31

Power Connector
(processor power)
connector

10

SATA (SATA0 –
SATA3) port
connectors

21

SLOT3 & SLOT4 PCI
32/33 card slots

11

PCI FAN (front chassis
fan)

22

SLOT2_PCIE (PCIExpress) x4(1) card
slot

System board components
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Steps for removing and replacing components
This section discusses the procedures necessary to remove and install various hardware components
on your workstation. Review the safety and precautions and the Service considerations on page 52, as
well as the Safety and Regulatory Information, before servicing or upgrading your system.
Follow these safety and procedural steps when servicing your workstation:
1.

Read all safety information and precautions.

2.

Locate and clear a suitable work area.

3.

Shut down the system and remove power from the unit.

4.

Gather your tools.

5.

Service your workstation.

6.

Restore power to your workstation.

Disassembly order
Use the following table to determine the sequence in which to remove the major components.

Predisassembly
(Predisassembly
procedures on page 57)
Locks (The optional
security lock on page 61)
Side access panel (Side access panel
on page 62)
Hood sensor (Optional
hood sensor (Smart cover
sensor) on page 64)
Front bezel (Front Bezel
on page 63)
Front panel I/O device assembly (Front
panel I/O device assembly on page 66)
Power button and front
speaker (Power button
on page 68)
Optical drive (Optical drive
(minitower configuration)
on page 84)
Diskette drive (Diskette
drive (optional)
on page 90)
Bezel blanks (Bezel
blanks on page 64)
Power supply (Power
supply on page 69)
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System fan (System fan
assembly on page 70)
Front fan removal
(optional) (Front PCI card
guide and optional fan
removal on page 80)
Battery (Battery
on page 81)
Hard drive (SATA hard
drive on page 92)
Processor heatsink (Processor heatsink
on page 95)
Processor (Processor
on page 97)
PCI retainer (PCI retainer on page 75)
PCI or PCI express card (PCI
on page 78)
Processor heatsink
(Processor heatsink
on page 95)
Processor (Processor
on page 97)
System board (System
board on page 98)

The optional security lock
If a security padlock is installed, remove it before servicing the workstation. To remove the padlock,
unlock it and slide it out of the padlock loop as shown in the following image.
Figure 4-3 Removing the security lock
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The optional cable lock
If a cable lock is installed, remove it before servicing the workstation. To remove the cable lock, unlock
it and pull it out of the cable lock slot as shown in the following image.
Figure 4-4 Removing the cable lock

Side access panel
To access the internal components of the workstation, the side access panel first must be removed.
To remove the side access panel:
WARNING! Electrical shock hazard. Before removing the workstation side access panel, be sure that
the workstation is powered off and that the power cord is disconnected from the electrical outlet.
1.

Disconnect power from the system
(Predisassembly procedures on page 57) and lay the workstation on its side as shown below.

2.
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If necessary, unlock any locks that are present (Cable lock or Padlock).
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3.

Pull up on the latch (1), slide the side access panel toward the rear of the workstation and then lift
off the cover (2).
Figure 4-5 Opening the side access panel

To reinstall the side access panel, align the bottom groove of the side access panel with the bottom
edge of the chassis, and move the top of the side access panel toward the chassis until the panel aligns
with chassis sides. Continue to press firmly until the latch engages.

Front Bezel
1.

Lift up on the two release snaps (1) located on the front bezel.

2.

Rotate the front bezel away (2) from the chassis to remove the bezel.

Figure 4-6 Opening the front bezel

To replace the front bezel, align front bezel on the bottom and rotate in until it snaps into place.
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Bezel blanks
To remove the bezel blanks:
1.

Disconnect power from the system (Predisassembly procedures on page 57) and remove the front
bezel (Front Bezel on page 63).

2.

Gently push the subpanel (1) out the back of the front bezel.

3.

Remove the desired bezel blank by applying outward pressure on the subpanel (1) and pulling the
blank (2) away.

Figure 4-7 Removing the bezel blanks

NOTE: The bezel blanks are keyed to assist you in replacing the blanks. Also, the subpanel can be
rotated 90 degrees to install the optical drives in desktop orientation if desired.

Optional hood sensor (Smart cover sensor)
To remove the optional hood sensor:
1.
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Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).
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2.

Disconnect the hood sensor connector (1) from system board. The hood sensor system board
connector is located between the main power connector (P1) and the SATA Port0 connector on
the system board (behind the installed hard drive, as shown in the inset (1) in the figure below).
Figure 4-8 Removing the hood sensor

3.

Slide the hood sensor forward, push it down, and remove it (2) from the chassis. .

To replace the hood sensor, reverse the previous steps.

Optional solenoid hood lock (Smart cover lock)
To remove the hood lock:
1.

Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).

2.

Disconnect the solenoid hood lock cable (1) from the system board.

3.

Using the FailSafe key (T-15 wrench), remove the two screws (2) from the back of the chassis as
shown in the following figure.
To purchase a FailSafe key, refer to the Hood lock (Smart cover lock) (optional) on page 47 section
of this document for detailed information.
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4.

Slide the solenoid hood lock assembly (3) away from the chassis and out of the workstation.
Figure 4-9 Removing the hood lock

To install the hood lock, reverse the previous steps.

Front panel I/O device assembly
To remove the front panel I/O device assembly:
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1.

Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62), and remove the front bezel (Front Bezel
on page 63).

2.

Unlatch the plastic snap that secures the cables inside the chassis and disconnect the front panel
I/O device assembly cables from the system board.

3.

Remove the two smaller Torx screws (1) that hold the front panel I/O device assembly (3) and
bracket to the chassis.

4.

Remove the two larger Torx screws (2) that hold the front panel I/O device assembly (3) to the
bracket.

5.

Separate the bracket away from the front panel I/O device assembly.

6.

Pull the front panel I/O device assembly out about two inches away (4) from the chassis.
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7.

Pull the front panel cables through the chassis and out the front of the workstation. You might have
to slide the cables out one at a time.
Figure 4-10 Removing the front panel I/O device assembly

To replace the front panel I/O device assembly:
1.

Thread each front panel I/O device assembly cable through the same holes from which they were
removed.

2.

Push the front panel I/O device assembly into the chassis. Using your fingers, orient the cables so
that there is enough room form the front panel I/O device assembly to easily fit in its slot.

3.

Loosely put the bracket on the front panel I/O device assembly and hook the bracket to the chassis.

4.

Screw the bracket to the front panel I/O device assembly and screw the bracket to the chassis.

5.

Connect the front audio cable to (1). Connect the front USB cable to (2). Connect the front control
panel cable to (3). If an IEEE-1394 card is installed, connect the front IEEE-1394 cable to the card.

Figure 4-11 Attaching front panel I/O device assembly cables
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Power button
To remove the power button:
1.

Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62), remove the front bezel (Front Bezel on page 63),
and remove the front panel I/O device assembly (Front panel I/O device assembly on page 66).

2.

Disconnect the power button assembly cable from the system board.

3.

Press in on the clips (1) that secure the power button to the chassis.

4.

Dislodge the metal clip from the chassis by rocking the power button back and forth. Then slide
the power button assembly (2) out from the front of the chassis.
Figure 4-12 Removing the power button

To replace the power button, reverse the previous steps.

System speaker
To remove the speaker:
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1.

Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).

2.

Disconnect the speaker cable (1) from the system board.
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3.

Remove the four screws (2) securing the speaker to the chassis and lift the speaker out (3) of the
chassis.
Figure 4-13 Removing the speaker

To replace the speaker, reverse the previous steps.

Power supply
To remove the power supply:
1.

Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).
TIP: This next step requires disconnecting several power cables. To speed up reinstalling the
power supply, it is helpful to write down the numbers on the cables so that you can easily reconnect
the cable to the correct devices.

2.
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Disconnect all cables from the system board, drives, or cards.
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3.

Remove the four screws (1) from the back panel.

4.

Slide the power supply toward the front and lift it (2) out of the chassis.

Figure 4-14 Removing the power supply

To replace the power supply, reverse the previous steps.

System fan assembly
To remove the system fan assembly:
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1.

Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).

2.

Disconnect the fan plug (1) from the system board.
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3.

Remove the four screws (2) from the rear of the chassis with a Phillips screwdriver, and lift it (3)
out of the chassis.
Figure 4-15 Removing the system fan

To replace the system fan assembly, reverse the previous steps.
CAUTION: When replacing the system fan, be sure that the fan is situated so that the airflow direction
arrow is pointing toward the rear of the chassis.

Memory
To remove a memory module:
1.

Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).
CAUTION: To ensure that memory modules are not damaged during removal or installation,
power off the workstation and unplug the power cord from the AC power outlet. If you do not unplug
the power cord while installing memory, your memory modules might be damaged and the system
will not recognize the memory changes.

2.
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Gently push outward on the socket levers (1).
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3.

Lift the DIMM (2) straight up and remove it from the workstation. Store the DIMM in an anti-static
bag.
Figure 4-16 Removing a memory module

Memory module features
Workstation memory module features include:
●

Four memory sockets for DIMMs

●

Support for configurations of 512 MB to 4 GB

●

Support for dual-channel DIMMs

Memory module requirements
CAUTION: Hewlett-Packard ships DIMMs with this product that are electrically and thermally
compatible with the product. Because third-party DIMMs might not be electrically or thermally
compatible, third-party DIMMs are not supported by HP.
NOTE:

Use only industry-standard unbuffered, DDR2, PC2–5300E ECC (667 MHz) DIMMs.

If multiple DIMMs are installed in a workstation, they must be installed in pairs of the same size and type
in both slot 1 and slot 2 of the same channel.
For supported DIMM configurations, see: http://www.hp.com/go/productbulletin to view the Quick Specs
for the HP xw4550 Workstation.
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Required loading order
Use the following illustration as a guide for installing memory modules:
●

When installing a single DIMM only, install it in socket DIMM1A (item 1 in the illustration, and as
shown on the system board label).

●

Always install the first DIMM pair in sockets DIMM1A and DIMM1B (items 1 and 2, respectively, in
the figure, and as shown on the system board label).

●

Install the second DIMM pair in sockets DIMM2A and DIMM2B (item 3 in the figure, and as shown
in the system board label).

Figure 4-17 System board DIMM sockets

To install a memory module:
1.

Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).

2.

Gently push outward on the socket locking levers to allow DIMMs to be inserted.
CAUTION: DIMM contact connectors and system board DIMM slots are keyed to guide proper
DIMM alignment. Always align the keyway on the DIMM contact connector to the key on the system
board DIMM slot when installing DIMMs to prevent damage to the DIMMs.

3.
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Lower the DIMM straight down (1) and secure the socket levers (2) into their locked position over
the ends of the memory modules.
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Figure 4-18 Installing a memory module

PCI Slots
This section contains information on PCI slots.
Your workstation contains two PCI slots (items 3 and 4 in the illustration), one PCI Express x4(1) slot
(item 2 in the illustration), and one PCI Express x16 (item 1 in the illustration). The PCI Express x16 is
normally used for high-performance graphics cards.
NOTE: The workstation integrated graphics capability is disabled when an optional graphics card is
installed in the PCI Express x16 slot.
Figure 4-19 Identifying the PCI slots
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Table 4-4 PCI slots
Slot

Type

Slot power (Maximum)

1

PCI Express x16

75 W*

2

PCI Express x4(1)

25 W*

3

PCI 32/33

25 W*

4

PCI 32/33

25 W*

* In addition to these slot power specifications, the overall power consumption of the system
(including I/O cards, processor, and memory) must not exceed the maximum ratings of the
system power supply.

PCI retainer
For added protection, some cards have PCI retainers installed to prevent movement during shipping.
To remove the PCI retainer:
1.

Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).

2.

Remove the two screws (1) retaining the retainer and lift it (2) out of the chassis.
Figure 4-20 Removing the PCI retainer

To install the PCI retainer:
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1.

Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).

2.

Engage the rear bracket (1) with the holes in the rear of the chassis before rotating it down (2) into
position. .
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3.

Secure the bracket with two screws (3).
Figure 4-21 Installing the PCI retainer

PCI Express
PCI Express improves system attributes. PCI Express enables a low-power, scalable, high-bandwidth
communication path with a small number of connections (wires) compared to traditional parallel
interfaces (for example, PCI). The PCI Express I/O slots can support other PCI Express cards with lesser
bus bandwidth than what is physically defined for the slot. Use the following table to determine
compatibility.
Table 4-5 PCI Express compatibility matrix for the HP xw4550 Workstation
Mechanical compatibility

Electrical compatibility

PCI Express x16 slot

x1, x4, x8 and x16 cards

x1 , x4, x8, and x16 modes

PCI Express x4(1)slot

x1 and x4 cards

x1 mode

To remove a PCI Express card:
1.

Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62), and remove the PCI retainer (PCI retainer
on page 75), if installed.

2.

Lift the PCI levers (1) by first pressing down and then up.

3.

If removing a PCI Express x16 graphics card, press in on the release lever (2) while lifting the card
(3) out of the chassis. Store the card in an anti-static bag.
If removing another type of PCI Express card, lift the card out of the chassis. You do not need to
press in on the release lever.
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4.

Install a PCI slot cover and close the PCI levers. If the PCI levers do not close, be sure all cards
are properly seated and then try again.
Figure 4-22 Removing the PCI Express card

To install a PCI Express card:
1.

Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62), and remove the PCI retainer (PCI retainer
on page 75), if installed.

2.

Lift the PCI levers (1) by first pressing down and then up.

3.

Remove the PCI slot cover (2).

4.

Lower the PCI Express card (3) into the chassis. Verify that the keyed components of the card align
with the socket.

5.

Close the PCI retention clamp (4) by rotating the clamp downward and pushing down on the two
green snaps from the rear panel of the chassis.
Figure 4-23 Installing the PCI Express card
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PCI
To remove a PCI card:
1.

Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62), and remove the PCI retainer (PCI retainer
on page 75), if installed.

2.

Lift the PCI levers (1) by first pressing down and then up.

3.

Lift the PCI card (2) out of the chassis. Store the card in an anti-static bag.

4.

Install a PCI slot cover and close the PCI levers. If the PCI levers do not close, be sure all cards
are properly seated and then try again.
Figure 4-24 Removing the PCI card

To install a PCI card:
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1.

Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62), and remove the PCI retainer (PCI retainer
on page 75), if installed.

2.

Lift the PCI levers (1) by first pressing down and then up.

3.

Remove the PCI slot cover (2).

4.

Lower the PCI (3) card into the chassis. Verify that the keyed components of the card align with
the socket.
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5.

Close the PCI retention clamp (4) by rotating the clamp downward and pushing down on the two
green snaps from the rear panel of the chassis.
Figure 4-25 Installing the PCI card

IEEE-1394 Card (optional)
To remove an IEEE-1394 card:
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1.

Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62), and remove the front bezel (Front Bezel
on page 63).

2.

Lift the PCI levers (1) by first pressing down and then up.

3.

Disconnect the front I/O cable and power cable (2) from the card.

4.

Lift the IEEE-1394 card (3) out of the chassis. Store the card in an anti-static bag.
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5.

Install a PCI slot cover and close the PCI levers. If the PCI levers do not close, be sure all cards
are properly seated and then try again.
Figure 4-26 Removing the IEEE-1394 card

To install an IEEE-1394 card, reverse the previous steps.

Front PCI card guide and optional fan removal
NOTE: The fan is used only for special configurations, but the card guide is used with all full-length
add-in cards.
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1.

Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62), and remove the front bezel (Front Bezel
on page 63).

2.

Disconnect the fan wire (1) from the PCI FAN connector on the system board and thread it out of
the card guide.
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3.

Unsnap the fan housing from the chassis (2) and lift it out of the chassis (3).
Figure 4-27 Removing the front (PCI) fan

4.

Remove the fan from the fan housing by applying outward pressure on the fan housing while
pushing the fan out of the housing.
Figure 4-28 Removing the fan from the card guide

To replace the front fan, reverse the previous steps, but be sure that the airflow direction arrow on the
side of the fan points to the rear of the chassis.

Battery
The battery that comes with the workstation provides power to the real-time clock and has a minimum
lifetime of approximately three years.
WARNING! This workstation contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in
water or fire, or expose it to temperatures higher than 140°F (60°C).
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CAUTION: Before removing the battery, be sure your CMOS settings are backed up as all CMOS
settings are lost when the battery is removed. To back up the CMOS settings, use the Computer Setup
(F10) Utility and run the Save to Diskette option from the File menu.
NOTE: Batteries, battery packs, and accumulators should not be disposed of together with general
household waste.
To remove the battery:
1.

Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).

2.

On the system board, press on the release tab of the battery holder.

3.

Rotate the battery enough to get beyond the latch and lift it straight up.

Figure 4-29 Removing the battery

To install the battery, confirm the polarity (positive-negative), position battery edge under plastic housing
tabs, and press down until the metal snaps engage.
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Workstation power connections to drives and the system board
For help in identifying power cables, refer to the following information. Route or tie cables so they cannot
interfere with the processor heatsink fan.
Figure 4-30 Power connections for a typical HP xw4550 Workstation configuration

Table 4-6 HP xw4550 Workstation power connections
Item

ENWW

Description

Item

Description

1

Workstation power supply

10

First hard drive

2

Power connector P6 (for
optional PCI card power)

11

Second hard drive

3

Power connector P7 to first
optical drive

12

Power connector P5 to
second hard drive
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Table 4-6 HP xw4550 Workstation power connections (continued)
Item

Description

Item

Description

4

Power connector P8 to
second optical drive

13

Power connector P1 to
system board

5

First optical drive

14

PCI slot (shows optional
IEEE 1394 PCI card with
optional adapter cable
connected to power
connector P6)

6

Second optical drive

15

Optional graphics card
(with power connection to
system board graphics
power connector P4)
NOTE: Disables
workstation integrated
graphics capability when
installed.

7

Power connector P9 to
diskette drive

16

6-pin system board
connector P4 for graphics
card auxiliary power
cable.

8

Diskette drive

17

Workstation system board

9

Power connector P4 to first
hard drive

18

4–pin power connector P3
to system board P3

Optical drive (minitower configuration)
Your workstation might have a SATA optical drive. To remove an optical drive:
To remove an optical drive:
1.
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Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62) and remove the front bezel (Front Bezel
on page 63).
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2.

Disconnect the power (1) and data (2) cables from the drive, as shown in the following figure.
Figure 4-31 Disconnecting the cables from the optical drive (minitower configuration)
Disconnecting the cables from the optical drive

3.

Lift the green drive-lock release lever (1) and gently slide the drive (2) out of the chassis.
Figure 4-32 Removing the optical drive from the chassis

ENWW

Steps for removing and replacing components

85

4.

If replacing this drive with another drive, remove the four guide screws (2), shown in the following
figure, and set them aside to be used in the replacement drive.
Figure 4-33 Removing the guide screws

To install an optical drive:
NOTE: Always connect optical drives to the lowest numbered available SATA port, or immediately
following any installed SATA hard drives. It is also important to connect all installed drives (both hard
drives and optical drives) beginning at SATA0 and progressing through SATA3, leaving no gap in port
numbering.
1.

Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62) and remove the front bezel (Front Bezel
on page 63).

2.

If not already installed, Insert the four guide screws (1), as shown in the following figure, into the
exterior of the drive housing.
Figure 4-34 Installing the optical drive
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3.

Align the screws with the grooves in the drive bay and gently slide the drive into the workstation
until it snaps into place (2).
CAUTION: Ensure that the optical drive is securely seated by pulling on it to see if the drive can
become easily disengaged. Failure to securely seat the drive might cause damage to the drive
when moving the workstation.

4.

Connect the power cable (2) first, then the data cable (in that order) to the drive and system board.
This will allow any possible accumulated static electricity to discharge through the ground circuit
of the power connector before the drive data circuits are connected.
NOTE: SATA ports on the system board must always be populated beginning with SATA0, and
leaving no gaps as additional ports are connected. Connect the optical drive data cable to the
lowest numbered SATA port still available.
Figure 4-35 Connecting the optical drive data cable

Optical drive (desktop configuration)
To remove an optical drive:
1.
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Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62) and remove the front bezel (Front Bezel
on page 63).
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2.

Disconnect the data (1) and power (2) cables from the drive.
Figure 4-36 Disconnecting the cables from the optical drive

3.

Press down on the yellow drive-lock release lever (1) and gently slide the drive 2 out of the chassis.
Figure 4-37 Removing the optical drive from the chassis
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4.

If the drive is to be replaced, remove the four installation guide screws (2), as shown in the following
figure, and set them aside.
Figure 4-38 Removing the optical drive screws

To install an optical drive:
1.

Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62) and remove the front bezel (Front Bezel
on page 63).

2.

If reinstalling an original optical drive, go to the next step. If installing a new drive or replacing the
original drive with replacement drive, insert four installation guide screws into the drive housing (1),
as shown in the following figure.
Figure 4-39 Installing the optical drive

3.

Align the guide screws with the grooves in the desired drive bay and gently slide the drive into the
workstation until it snaps into place (2), as shown in the preceding figure.
CAUTION: Ensure that the optical drive is secure by pulling to see if the drive can become easily
disengaged. Failure to do so can cause damage to the drive when moving the workstation.
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4.

Connect the power cable to the drive first. This will allow any possible accumulated static electricity
to discharge through the ground circuit of the power connector before the drive data circuits are
connected. Next, connect the data cable from the drive (1) and system board (2), as shown in the
following figure.
NOTE: Always connect optical drives to the lowest numbered available SATA port, or
immediately following any installed SATA hard drives. It is also important to connect all installed
drives (both hard drives and optical drives) beginning at SATA0 and progressing sequentially
upward, and leaving no gap between ports SATA0 and SATA3 on the system board.
Figure 4-40 Connecting the optical drive data cable to the system board

Diskette drive (optional)
To remove a diskette drive:
1.
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Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62), and the front bezel (Front Bezel on page 63).
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2.

Disconnect the data (1) and power (2) cables from the back of the diskette drive.
Figure 4-41 Disconnecting the cables from the diskette drive

3.

Lift the green drive-lock release tab (1) and gently slide the drive 2 out at the same time.
Figure 4-42 Removing the diskette drive from the chassis

To replace a diskette drive:
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1.

Align the metal protrusions on the side of the drive with the grooves in the diskette drive bay and
slide the diskette drive into the bay until it stops.

2.

Connect the power cable first, then the data cable (in that order) to the drive and the system board.
This sequence will allow any possible accumulated static electricity to discharge through the ground
circuit of the power connector before the drive data circuits are connected.

3.

Connect the cables to the back of the diskette drive.
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SATA hard drive
To remove a hard drive:
1.

Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).

2.

Disconnect the data (1) and power (2) cables from the hard drive.
Figure 4-43 Removing the hard drive cables

3.

Lift up on the green drive-lock release tab (1) and slide the hard drive (2) out of the chassis.
Figure 4-44 Removing the hard drive from the chassis
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4.

If you will be replacing the hard drive with a replacement drive, remove the four installation guide
screws from the drive housing (as shown in the following figure) and retain them for reuse.
Figure 4-45 Removing hard drive installation guide screws

To install a SATA hard drive:
NOTE: Always connect SATA hard drives to the two lowest numbered ports on the system board
(SATA0 and SATA1), and always beginning with SATA0.
A third and fouth SATA hard drive are not supported by the HP xw4550 Workstation.
1.

Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62).

2.

Select a drive bay in which to install the drive.

3.

If installing a new or replacement drive, install four guide screws in the hard drive housing (as shown
in the following figure), and carefully slide the drive into the selected bay until it snaps into place.
If reinstalling an existing hard drive, ensure the original installation guide screws are inserted in the
drive housing, align the screws with the screw slots in the chosen drive bay, and carefully slide the
drive into the bay until it snaps into place.
Figure 4-46 Installing hard drive installation guide screws
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4.

Connect the power cable (2) to the drive (as shown in the following figure). This will allow any
possible accumulated static electricity to discharge through the ground circuit of the power
connector before the drive data circuits are connected.
Figure 4-47 Installing the SATA hard drive

5.

Connect the data cable (1) between the hard drive (shown in the previous figure) and the
appropriate serial ATA port (2 in the following figure) using the following port connection sequence:
●

Connect the first hard drive (SATA 0) to port SATA0 on the system board.

●

Connect the second hard drive (SATA 1) to port SATA1 on the system board.

Figure 4-48 Connecting the SATA data cable
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Processor heatsink
NOTE: The following illustrated processor heatsink is typical of what you might have in your
workstation. Be aware that different variations of the processor heatsinks exist, but the overall
procedures listed are sufficient to assist you in removing the processor heatsink.
To remove the processor heatsink:
1.

Apply power to the workstation for a minimum of five minutes before proceeding to the next step.
Heat generated by this process will cause the thermal grease between the heatsink and processor
surfaces to become less viscous, thereby allowing the heatsink to be separated from the processor
with minimum force.

2.

Shut down and disconnect power from the workstation, and remove the side access panel.

3.

Loosen the four processor screws slowly and evenly, loosening them two at a time as a diagonally
opposing pair.
NOTE: Do not fully loosen one screw, and then move on to the next. Loosen all of the screws a
little at a time, being sure the processor remains level to the system board.
Figure 4-49 Identifying proper screw loosening sequence
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4.

Disconnect the heatsink fan cable (1) from the system board.

5.

Gently twist the heatsink unit to break the thermal grease binding.
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6.

Lift the heatsink (2) from the processor.
Figure 4-50 Removing the processor heatsink from the system board

7.

Use alcohol and a soft cloth to clean all of the thermal interface residue from the heatsink and
processor.
CAUTION:

Allow the alcohol on the processor and heatsink to dry completely.

To replace the processor heatsink:
1.

Disconnect power from the system (Predisassembly procedures on page 57). Remove the side
chassis access panel (Side access panel on page 62).

2.

Check for proper processor seating in the socket by carefully trying to lift the processor out of the
socket with your fingers. A properly seated processor does not lift out of the socket.

3.

If reusing the original heatsink, apply thermal grease to the center of the processor top surface. If
using a new processor heatsink, do not apply thermal grease to the processor; the a new heatsink
will have grease already applied to the heatsink surface. In this case, discard the thermal grease
protective liner from the bottom of the new heatsink before installing.
NOTE: Do not touch the exposed thermal grease when handling the processor heatsink.

4.

Lower the processor heatsink onto the system board over the processor.

5.

Carefully tighten the four screws a little at a time; do not fully tighten one screw and move onto the
next. Be sure the processor remains level and be sure you do not overtighten the screws. If you
have a torque-limited driver available, tighten the screws to the correct torque setting of 6 in-lbs.
CAUTION: Do not overtighten the screws. If you overtighten the screws, you risk stripping the
threads in the system board tray.

96

Chapter 4 Removal and replacement procedures

ENWW

Processor
To remove the processor:
1.

Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62) and the processor heatsink (Processor heatsink
on page 95).

2.

Raise the lever (1) on the processor socket handle to slide the processor into position for removal
(as shown in the following illustration).

3.

Pull the processor (2) straight up and out of the socket.
Figure 4-51 Raising the processor socket handle

NOTE:

Immediately store the processor in a static-safe container where it will not be damaged.

To replace the processor:
1.

Disconnect power from the system (Predisassembly procedures on page 57), remove the side
access panel (Side access panel on page 62), the processor heatsink (Processor heatsink
on page 95), and the processor (Processor on page 97).

2.

Raise the processor socket handle fully (the full swing angle of the lever is approximately 90
degrees).
CAUTION: Processor pins are delicate and bend easily. Use extreme care when aligning and
inserting the processor pins into the socket to avoid bending the pins.
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3.

To properly align the processor with the socket, orient the small triangle image located on one
corner of the processor circuit board to the matching triangle image on one corner of the processor
socket (see illustration below). With all processor pins properly aligned, press the processor straight
down into the socket until the processor is seated.
Figure 4-52 Seating and locking the processor

4.

Ensure that the underside of the processor is sitting level with the top of the processor socket, then
press lightly on the top of the processor while simultaneously closing the socket lever to the locked
position (as shown in the above illustration).

5.

Check for proper processor seating in the socket by carefully trying to lift the processor out of the
socket with your fingers. A properly seated processor does not lift out of the socket.

System board
To remove the system board:
1.

Disconnect power from the system (Predisassembly procedures on page 57) and remove the side
access panel (Side access panel on page 62), remove all expansion boards, and graphics cards.

2.

Disconnect all cabling from the system board and remove all I/O cards.
NOTE: Make note of the cable connections before disconnecting them from the system board.
Refer to Workstation power connections to drives and the system board on page 83 for more
information.
NOTE: It is not necessary to remove the processor heatsink before removing the system board.

3.

98

Press the release tab (1) as shown in the following illustration.
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4.

Slide the system board toward the front of the chassis and then lift it (2) out of the workstation.
Figure 4-53 Removing the system board

To replace the system board:
1.

Lay the system board back in the chassis slightly away from the rear of the chassis. The mounting
hooks should fall into the recesses of the tray so the tray lays flat on the chassis base.

2.

Slide the tray towards the rear of the chassis until the heatsink mounting holes align.

3.

Reinstall the processor heatsink, cards, and cables.

Product recycling
HP Planet Partners recycling service provides an easy method to recycle computer equipment,
rechargeable batteries or HP printing supplies. HP processes ensure that unwanted hardware or empty
HP printing supplies are recycled responsibly.
For information on recycling HP components or products, see: http://www.hp.com/go/recycle.
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5

System diagnostics and
troubleshooting

This chapter discusses the tools available for diagnosing and troubleshooting system issues.
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●

Customer self help on page 102

●

Troubleshooting checklist on page 120

●

LED color definitions on page 121

●

HP Insight Diagnostics Offline Edition on page 122

●

POST error messages on page 127
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Customer self help
This section provides information on the following areas of customer self help:
●

Help and Support Center

●

HP SoftPaq Download Manager

●

Diagnostic error codes

●

Troubleshooting scenarios and solutions

Help and Support Center
The Help and Support Center (HSC) provides online access to technical support information, software
updates and downloads, diagnostic tools, and HP support contact information.
To open HSC from your desktop, select Start>Help and Support.
HSC contains four sections:
●

HP Product Information (requires Internet access) – Links to the HP Technical Support Web site
for your product. You can access all related documentation, downloads and updates, tools, and
more.

●

HP Software and Driver Downloads (requires Internet access) – Links to HP specific software
downloads and updates.

●

HP Support Tools (requires Internet access) – Links to self-help tools and diagnostics offered by
HP Instant Support Professional Edition.

●

Contact HP for Support (does not require Internet access) – Provides two different options:
◦

Chat with an expert online (requires Internet access) – Provides a tool to communicate with
a support specialist online through Active Chat.

◦

Call a support agent – Provides hardware details about the workstation and HP support
contact phone number worldwide.

HP SoftPaq Download Manager
The HP SoftPaq Download Manager enables you to download software updates for your workstation
from the HP support site. To use the download manager:
1.

See http://h20331.www2.hp.com/Hpsub/cache/509658-0-0-225-121.html.

2.

Select the desired workstation model, operating system, and language, then click Find Available
SoftPaqs. All available SoftPaqs matching the selected criteria are displayed.

3.

Check the updates you wish to download.

4.

Click the Download button.

Diagnostic error codes
This section provides an overview of the diagnostic LEDs and error codes that are related to your
workstation.
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NOTE: The diagnostic beeps are audible through the chassis speaker. Both the flashing LEDs and
audible beeps repeat for five cycles. Following that, only the flashing LEDs continue to repeat.
Table 5-1 Diagnostic LED codes
Chassis indicator LEDs
Diagnosis and service action

Power LED and audible beep
activity
None

System does not power on. Press the power button. If HDD LED = GREEN, then:
1.

Remove expansion cards one at a time.

2.

Replace the system board.

OR
Press the power button. If HDD LED does not illuminate, then:

Blinks red 2 times, once per
second, then 2-second pause,
2 beeps

Blinks red 3 times, once per
second, then 2-second pause,
3 beeps

Blinks red 4 times, once per
second, then 2-second pause,
4 beeps

Blinks red 5 times, once per
second, then 2-second pause,
5 beeps

Blinks red 6 times, once per
second, then 2-second pause,
6 beeps
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1.

Verify that the workstation is plugged into a working AC outlet.

2.

Open access panel and verify that the power button harness is properly connected
to the inline front panel I/O device assembly connector.

3.

Verify that the power supply cables are properly connected to the system board.

Thermal shutdown has occurred:
1.

Ensure that the workstation air vents are not blocked and the cooling fan is
running.

2.

Open the access panel, press power button, and determine whether the processor
fan spins. If it does not spin, ensure the fan cable is plugged into the system board.
Ensure that the fan is properly seated.

3.

If the fan is plugged in and seated but not spinning, then replace processor fan.

4.

Reseat the processor heatsink and verify that the fan assembly properly attached.

Processor not installed.
1.

Install processor.

2.

Reseat processor.

Power supply failure.
1.

Open the access panel and ensure the four-wire power supply cable is properly
connected to the system board power connector P3.

2.

Locate faulty device by removing all devices and then reinstalling one at a time
until workstation fails. Replace the device causing the failure. Continue adding
devices to ensure all are functioning properly.

Pre-video memory error.
1.

Reseat memory modules.

2.

Replace memory modules one at a time to find the faulty module.

3.

Replace third-party modules with HP memory.

4.

Replace system board.

Pre-video graphic card error.
For systems with integrated graphics, replace system board.
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Table 5-1 Diagnostic LED codes (continued)
Chassis indicator LEDs
Diagnosis and service action

Power LED and audible beep
activity

For systems with graphic cards:
1.

Reseat the graphic card. Power on the system.

2.

Replace the graphic card.

3.

Replace the system board.

Blinks red 7 times, once per
second, then 2-second pause,
7 beeps.

System board failure (ROM detected failure before video).

Blinks red 8 times, once per
second, then 2-second pause,
8 beeps

Invalid ROM based on bad checksum.

Blinks red 9 times, once per
second, then 2-second pause,
9 beeps

Replace system board.

1.

Reflash ROM.

2.

Replace system board.

System powers on but is unable to boot.
1.

Replace the system board.

2.

Replace the processor.

Troubleshooting scenarios and solutions
This section presents an extensive overview of various troubleshooting scenarios and includes possible
solutions for each.

Solving minor problems
Table 5-2 Minor problems
Problem
Workstation appears locked up
and will not shut down when the
power button is pressed.
Workstation seems to be locked
up.
Workstation date and time display
is incorrect.

Cause
Software control of the power
switch is not functional.

Program in use has stopped
responding to commands.
Real-time clock (RTC) battery
might need to be replaced.

Possible Solution
1.

Press and hold the power button for at least four
seconds until the workstation shuts down.

2.

Disconnect electrical plug from outlet.

1.

Attempt the normal Windows shutdown procedure.

2.

Restart the workstation using the power button.

1.

Reset the date and time under Control Panel.

2.

Replace the RTC battery.

Workstation appears to pause
periodically.

Network driver is loaded and no
network connection is
established.

Establish a network connection, or use the Computer Setup
(F10) Utility or Microsoft Windows Device Manager to
disable the network controller.

Cursor will not move using the
arrow keys on the keypad.

The Num Lock key might be on.

Press the Num Lock key. The Num Lock key can be
disabled (or enabled) in Computer Setup.
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Table 5-2 Minor problems (continued)
Problem

Cause

Poor performance is experienced. Processor is hot.

Workstation powered off
automatically and the Power LED
flashes red 2 times, once every
second, followed by a 2-second
pause, and two simultaneous
audible beeps.

System does not power on, and
the LEDs on the front of the
workstation are not flashing.

Possible Solution
1.

Ensure airflow to the workstation is not blocked.

2.

Ensure the fans are connected and working properly
(some fans only operate when needed).

3.

Ensure the processor heatsink is installed properly.

Hard drive is full.

Transfer data from the hard drive to create more space on
the hard drive.

Processor thermal protection
activated.

1.

Be sure workstation air vents are not blocked and the
cooling fan is running.

A fan might be blocked or not
turning.

2.

Open the access panel, press the power button, and
see if the processor fan spins. If not spinning, be sure
the fan cable is plugged into the system board header.
Ensure the fan is fully and properly seated or installed.

The processor heatsink is not
properly attached to
the processor.

3.

Replace the processor fan.

4.

Reseat processor heatsink and verify that the fan
assembly is properly attached.

System unable to power on.

Press and hold the power button for less than 4 seconds. If
the hard drive LED turns green, then:

OR

1.

Remove the expansion cards.

2.

Replace the system board.

OR
Press and hold the power button for less than 4 seconds. If
HDD LED does not illuminate, then:
1.

Verify that the workstation is plugged into a working AC
outlet.

2.

Open the workstation access panel and verify that the
power button harness is properly connected to the
inline front panel I/O device assembly connector.

3.

Verify that the power supply cables are properly
connected to the system board.

Solving power supply problems
This section presents troubleshooting information for power supply problems.
Table 5-3 Power supply problems
Problem
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Cause

Solution

Power supply shuts down
intermittently.

Power supply fault.

Replace the power supply.

After AC power is applied, system
powers up for 2-3 seconds and then
powers down.

This behavior is normal. The
system is restoring WOL
settings lost during AC power
loss.

No action required. This behavior occurs whether or not
WOL is enabled.
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Table 5-3 Power supply problems (continued)
Problem

Cause

Solution

Workstation powered off
automatically and the Power LED
flashes red 2 times, once every
second, followed by a 2-second
pause.

Processor thermal protection
activated.

1.

Be sure that the workstation air vents are not blocked
and the cooling fan is running.

A fan might be blocked or not
turning.

2.

Open the access panel, press the power button, and
determine whether the processor fan spins. If the
processor fan is not spinning, be sure the fan’s cable
is plugged into the system board header. Be sure the
fan is properly seated or installed.

3.

Replace the processor fan.

4.

Reseat processor heatsink and verify that the fan
assembly is properly attached.

OR
The processor heatsink fan
assembly is not properly
attached to the processor.

Power LED flashes red 4 times,
once every 2 seconds.

Power failure (power supply is
overloaded).

Determine if a device is causing the problem: Power off the
workstation, remove all attached devices, and power on
the workstation. If the workstation enters the POST, power
off the workstation, reinstall one of the removed devices,
and power on the workstation again. If the workstation
continues to enter the POST, power off the workstation,
reinstall the next device that was removed, and power on
the workstation. Repeat this procedure until failure occurs
with the most recently reinstalled device. Replace the
device causing the failure. Continue adding devices one at
a time to ensure all devices are functioning properly.

Solving diskette problems
Table 5-4 Diskette problems
Problem
Diskette drive light stays on.

Drive not found.

Diskette drive cannot write to a
diskette.

Cause

Solution

Diskette is damaged.

In Microsoft Windows Vista or XP, right-click Start,
click Explore, and select a drive. Select
File>Properties>Tools. Under Error-checking, click
Check Now.

Diskette is incorrectly inserted.

Remove and reinsert diskette.

Files on diskette are damaged.

Verify the program diskettes.

Drive cable is not properly
connected.

Reconnect power cable. Verify that all four pins are
connected.

Cable is loose.

Reseat diskette drive data and power cables.

Removable drive is not seated
properly.

Reseat the drive.

Diskette is not formatted.

Format the diskette.

Diskette is write-protected.

Use another diskette or remove the write protection.

Writing to the wrong drive.

Verify the drive letter in the path statement.

Not enough space is left on the
diskette.

Use another diskette.

Diskette write control is
enabled.

Use the Computer Setup (F10) Utility to verify the storage
security feature disabled settings.

Diskette is damaged.

Replace the damaged disk.
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Table 5-4 Diskette problems (continued)
Problem
Cannot format diskette.

Cause
Invalid media reported.

Solution
When formatting a disk in MS-DOS, you might need to
specify diskette capacity. For example, to format a 1.44MB diskette, enter the following command at the MSDOS prompt:
FORMAT A: /F:1440

A problem has occurred with a disk
transaction.

The directory structure is bad,
or there is a problem with a file.

In Windows Vista or XP, right-click Start, click Explore,
and select a drive. Select File>Properties>Tools. Under
Error-checking, click Check Now.

Diskette drive cannot read
a diskette.

Diskette is not formatted.

Format the diskette.

You are using the wrong
diskette type for the drive type.

Verify the type of drive that you are using and use the
correct diskette type.

You are reading the wrong
drive.

Verify the drive letter in the path statement.

Diskette is damaged.

Replace the diskette with a new one.

“Invalid system disk” message is
displayed.

Cannot Boot to Diskette.

A diskette that does not contain When drive activity stops, remove the diskette and press
the system files needed to start the Spacebar. The workstation should start up.
the workstation has been
inserted in the drive.
Diskette error has occurred.

Restart the workstation by pressing the power button.

Diskette is not bootable.

Replace with a bootable diskette.

Diskette boot has been
disabled in Computer Setup.

Run the Computer Setup (F10) Utility and enable diskette
boot in Storage>Boot Order.

Removable media boot has
been disabled in Computer
Setup.

Run the Computer Setup (F10) Utility and enable
Removable Media Boot in Storage>Storage Options.

Diskette MBR validation is
enabled.

Run the Computer Setup (F10) Utility and disable
Diskette MBR Validation in Storage>Storage Options.

Solving hard drive problems
Table 5-5 Hard drive problems
Problem
Hard drive error occurs.

Cause
Hard disk has bad sectors or
has failed.

Solution
Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.
Or, run DPS Self-test if the drive is detected by the BIOS.
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Disk transaction problem.

The directory structure is bad,
or there is a problem with a file.

Right-click Start, click Explore, and select a drive.
Select File>Properties>Tools. Under Error-checking,
click Check Now.

Drive not found (identified).

Loose cable.

Verify cable connections.
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Table 5-5 Hard drive problems (continued)
Problem

Cause
The system might not have
automatically recognized a
newly installed device.

Solution
1.

Run the Computer Setup (F10) Utility.

2.

If the system still does not recognize the new device,
verify to see if the device is listed within Computer
Setup. If it is listed, the probable cause is a driver
problem. If it is not listed, the probable cause is a
hardware problem.

3.

If this drive is newly installed, enter Setup and try
adding a POST delay under Advanced>Power-On.

Drive jumper settings might be
incorrect.

If the drive is a secondary drive that has just been installed
on the same cable as the primary drive, verify that the
jumpers for both drives are set correctly.

Drive responds slowly
immediately after power-up.

Run the Computer Setup (F10) Utility and increase the
POST Delay in Advanced>Power-On Options.

Non-system disk/NTLDR missing
message.

System is trying to start from a
non-bootable diskette.

Remove the diskette from the diskette drive.

Non-system disk/NTLDR missing
message.

System is trying to start from a
damaged hard drive.

1.

Insert a bootable diskette into the diskette drive and
restart the workstation.

2.

If the hard drive is still inaccessible and MBR Security
is enabled, try restoring the previously saved
MBR image by entering Setup and selecting
Security>Restore Master Boot Record.

1.

Insert a bootable system diskette and restart.

2.

Verify that the hard drive is partitioned and formatted.

3.

Install system files for the appropriate operating
system if necessary.

System files missing or not
properly installed.

Workstation will not start.

Hard drive boot disabled in
Computer Setup.

Run the Computer Setup (F10) Utility and enable the hard
drive entry in the Storage>Boot Order list.

Hard drive is damaged.

Observe the beeps and LEDs on the front of the
workstation. Refer to POST error messages
on page 127.

Solving display problems
Table 5-6 Display problems
Problem
Blank screen (no video).

Cause

Solution

The cable connections are not
correct.

Verify the cable connections from the monitor to the
workstation and to a working electrical outlet.

The monitor is off.

Switch the monitor to on (LED is on). You might need to
refer to the monitor manual for an explanation of the LED
signals.

Screen blanking utility installed
or energy saver features
enabled.

Press any key or click the mouse button, and, if set, enter
your password.

System ROM is bad; system is Reflash the ROM using SoftPaq. You can reflash the ROM,
running in FailSafe Boot Block using the latest SoftPaq images downloaded from
mode (indicated by 8 beeps).
http://www.hp.com/support/workstation_swdrivers
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Table 5-6 Display problems (continued)
Problem

The display works properly during
the POST but goes blank when the
operating system starts.

Power LED flashes red 6 times,
once every second, followed by a
2-second pause, and the
workstation beeps 6 times.

Solution

Fixed-sync monitor will not
sync at the resolution chosen.

Be sure that the monitor can accept the same horizontal
scan rate as the resolution chosen.

Computer is in Hibernate
mode.

Press the power button to resume from Hibernate mode.

Monitor settings in the
workstation are not compatible
with the monitor.

1.

Restart the workstation and press F8 during startup
when you see Press F8 in the bottom-right corner of
the screen.

2.

Use the keyboard arrow keys to select Enable VGA
Mode and press Enter.

3.

In Windows Control Panel, double-click the Display
icon and select the Settings tab.

4.

Use the sliding control to reset the resolution.

1.

Restart your workstation in VGA mode.

2.

After the operating system starts, change the display
settings to match those supported by your graphics
card and monitor.

3.

Refer to your operating system and graphics card
documentation for information on changing display
settings.

The display settings in the
operating system are
incompatible with your
graphics card and monitor.

Pre-video graphics error.

For systems with a graphics card:
1.

Reseat the graphics card.

2.

Replace the graphics card.

3.

Replace the system board.

Monitor does not function properly
when used with energy saver
features.

Monitor without energy saver
capabilities is being used with
energy saver features
enabled.

Disable monitor energy saver feature.

Dim characters.

The brightness and contrast
controls are not set properly.

Adjust the monitor brightness and contrast controls.

Cables are not properly
connected.

Verify that the graphics cable is securely connected to the
graphics card and the monitor.

If the graphics controller was
upgraded, the correct video
drivers might not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of
displaying requested
resolution.

Change requested resolution.

The monitor connections might
be incomplete, or the monitor
might be incorrectly adjusted.

1.

Ensure the monitor cable is securely connected to the
workstation.

2.

In a two-monitor system or if another monitor is in
close proximity, ensure the electromagnetic field of
each monitor is not interfering with the other monitor
by moving them further from each other.

3.

Fluorescent lights or fans might be too close to the
monitor.

Blurry video or requested
resolution cannot be set.

The picture is fragmented, rolls,
jitters, or flashes.
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Cause
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Table 5-6 Display problems (continued)
Problem

Cause

Solution

Monitor must be degaussed.

Degauss the monitor.

Vibrating or rattling noise coming
from inside a CRT monitor when
powered on.

Monitor degaussing coil has
been activated.

None. It is normal for the degaussing coil to be activated
when the monitor is powered on.

Clicking noise coming from inside a
CRT monitor.

Electronic relays have been
activated inside the monitor.

None. It is normal for some monitors to make a clicking
noise when turned on and off, when going in and out of
Standby mode, and when changing resolutions.

High pitched noise coming from
inside a flat-panel monitor.

Brightness and contrast
settings are too high.

Lower brightness and contrast settings.

Fuzzy focus; streaking, ghosting,
or shadowing effects; horizontal
scrolling lines; faint vertical bars; or
unable to center the picture on the
screen. (Flat-panel monitors using
an analog VGA input connection
only.)

Flat-panel monitor internal
digital conversion circuits
might be unable to correctly
interpret the output
synchronization of the graphic
card.

1.

Select the monitor Auto-Adjustment option in the
monitor on-screen display menu.

2.

Manually synchronize the Clock and Clock Phase onscreen display functions. Download SoftPaq
SP20930 or SP22333, depending on the monitor, to
assist with the synchronization. You can download
the most recent SoftPaq release from:
http://www.hp.com/support/workstation_swdrivers

Certain typed symbols do not
appear correctly.

The font you are using does
not support that particular
symbol.

Use the Character Map to locate the and select the
appropriate symbol. ClickStart>All Programs>
Accessories>System Tools>Character Map. You can
copy the symbol from the Character Map into a document.

Solving audio problems
Table 5-7 Audio problems
Problem
Sound does not come out of the
speaker or headphones.

Cause

Solution

Software volume control is
turned down.

Double-click the Speaker icon on the taskbar and use the
volume slider to adjust the volume.

The external speakers are not
turned on.

Turn on the external speakers.

External speakers plugged into
the wrong audio jack.

See the sound card documentation for proper speaker
connection.

Audio cable not connected.

Connect audio cable between DVD-ROM drive and the
system board.

Digital CD audio is
not enabled.

Enable digital CD audio:

Headphones or devices
connected to the line-out
connector mute the internal
speaker.
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1.

From the Control Panel, select System.

2.

On the Hardware tab, click the Device Manager
button.

3.

Right-click the CD/DVD device and select
Properties.

4.

On the Properties tab, be sure Enable digital CD
audio for this CD-ROM device is selected.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external
speakers.
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Table 5-7 Audio problems (continued)
Problem

Cause
Volume is muted.

Computer is in Standby mode.
Noise or no sound comes out of the
speakers or headphones.

Solution
1.

From the Control Panel program, click Sound,
Speech and Audio Devices, then click Sounds and
Audio Devices.

2.

Click the Mute checkbox to remove the checkmark
from the box.

Press the power button to resume from Standby mode.
1.

If using digital speakers that have a stereo jack and
want the system to auto-switch to digital, use a stereoto-mono adapter to properly engage the auto-sense
feature or use the multimedia device properties
to manually switch the audio signal from analog to
digital.

2.

If the headphones have a mono jack, use the
multimedia device properties to switch the system to
analog out.

NOTE: If you set digital as the Output Mode, the internal speaker and external analog speakers will no longer output audio until
you switch back to an auto-sense or analog mode.
If you set analog as the Output Mode, external digital speakers will not function until you change the output mode back to an
auto-sense or digital mode.
The sound occurs intermittently.

Processor resources are being
used by other open
applications.

Shut down all open processor-intensive applications.

Workstation appears to be locked
up while recording audio.

The hard disk might be full.

1.

Before recording, be sure there is enough free space
on the hard disk.

2.

Try recording the audio file in a compressed format.

Solving printer problems
Table 5-8 Printer problems
Problem
Printer does not print.

Cause

Solution

Printer is not turned on and
online.

Turn the printer on and be sure it is online.

The correct printer driver for
the application is not installed.

1.

Install the correct printer driver for the application.

2.

Try printing using the MS-DOS command:
DIR C:\> [printer port]
where [printer port] is the address of the printer
being used. If the printer works, reload the printer
driver.

Printer does not turn on.
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If you are on a network, you
might not have made the
connection to the printer.

Make the proper network connections to the printer.

Printer might have failed.

Run printer self-test.

The cables might not be
connected properly.

Reconnect all cables.
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Table 5-8 Printer problems (continued)
Problem

Cause

Printer prints garbled information.

The correct printer driver is not
installed.

Install the correct printer driver for the application.

The cables might not be
connected properly.

Reconnect all cables.

Printer memory might be
overloaded.

Reset the printer by turning it off for one minute, then turn
it back on.

The printer might be out of
paper.

1.

Verify the paper tray and refill it if it is empty.

2.

Select online.

Printer is offline.

Solution

Solving keyboard and mouse problems
Table 5-9 Keyboard and mouse problems
Problem
Keyboard commands and typing
are not recognized by the
workstation.

Cause
Keyboard connector is not
properly connected.

Solution
1.

Power off the workstation.

2.

Reconnect the keyboard to a workstation USB
connector and restart the workstation.

Program in use has stopped
responding to commands.

Shut down the workstation using the mouse, and then
restart the workstation.

Keyboard needs repairs.

Replace the keyboard.

Keyboard key is stuck down.

Remove any debris from the keyboard.

Workstation is in Hibernate
mode.

Press the power button to resume from Hibernate mode.

Cursor will not move using the
arrow keys on the keypad.

The Num Lock key might be
on.

Press the Num Lock key. The Num Lock light should not
be on if you want to use the arrow keys. The Num Lock key
can be disabled or enabled in the Computer Setup (F10)
Utility.

Mouse does not respond to
movement or is too slow.

Mouse connector is
not properly plugged into the
back of the workstation.

1.

Shut down the workstation using the keyboard.

2.

Connect the mouse to a workstation USB connector
and restart the workstation.

Program in use has stopped
responding to commands.

Shut down the workstation using the keyboard and then
restart the workstation.

Mouse needs repairs.

Replace the mouse.

Workstation is in Standby
mode.

Press the power button to resume from Standby mode.

Mouse roller ball is dirty.

Remove roller ball cover from the bottom of the mouse and
clean the ball. Then, replace cover.

Mouse will only move vertically or
horizontally, or movement is jerky.

Solving front panel component problems
If you are experiencing problems with one of the front panel ports, you might be able to try your device
in the corresponding port on the rear of the computer. If this does not correct the problem or you must
use the front panel ports, continue troubleshooting.
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Some problems in this section are also discussed in other troubleshooting suggestions in this chapter.
Table 5-10 Front panel component problems
Problem
A USB device, headphone, or
microphone is not recognized by
the workstation.

Cause
The device is not properly
connected.

The device does not have
power.

A device in the IEEE-1394 port is
not responsive.

The IEEE-1394 port is not active.

1.

Power off the workstation.

2.

Reconnect the device to the front of the workstation
and restart the workstation.

If the USB device requires AC power, be sure one end is
connected to the device and one end is connected to a live
outlet.

The correct device driver is not 1.
installed.
2.

Install the correct driver for the device.

The cable from the device to
the computer does not work.

1.

If possible, replace the cable.

2.

Restart the workstation.

1.

Replace the device.

2.

Restart the workstation.

The internal cables might not
be connected to the system
board or the PCI card.

1.

Power off the workstation.

2.

Connect the cables correctly.

Cables of new external device
are loose, or power cables are
unplugged.

Ensure that all cables are properly and securely connected.

The power switch on the
device is not turned on.

Power off the workstation, power on the external device,
then power on the workstation to integrate the device
with the workstation system.

The device is not working.

A USB, audio, or IEEE-1394
devices is not working.

Solution

You might need to reboot the workstation.

The port is not there because it You can purchase an IEEE 1394 PCI adapter card. Contact
was not purchased with the
an HP seller.
system.

Solving hardware installation problems
You might need to reconfigure the workstation when you add or remove hardware, such as an additional
diskette drive. If you install a Plug and Play (PnP) device, the operating system automatically recognizes
the device and configure the workstation. If you install a non-PnP device, you must reconfigure the
workstation after completing installation of the new hardware.
Table 5-11 Hardware installation problems
Problem
A new device is not recognized as
part of the system.
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Cause

Solution

Device is not seated or
connected properly.

Ensure that the device is properly and securely connected
and that pins in the connector are not bent down.

Cables of new external device
are loose, or power cables are
unplugged.

Ensure that all cables are properly and securely connected
and that pins in the cable or connector are not bent down.

Power switch of new external
device is not turned on.

Power off the workstation, power on the external device,
then power on the workstation to integrate the device
with the workstation system.

Customer self help 113

Table 5-11 Hardware installation problems (continued)
Problem

Cause

Workstation will not start.

Power LED flashes red 5 times,
once every second, followed by a
2-second pause, and the
workstation beeps 5 times.

Power LED flashes red 6 times,
once every second, followed by a
2-second pause, and the
workstation beeps 6 times.

Solution

When the system advised you
of changes to the
configuration, you did not
accept them.

Reboot the workstation and follow the instructions for
accepting the changes.

A PnP board might not
automatically configure when
added if the default
configuration conflicts with
other devices.

Use Device Manager to deselect the automatic settings for
the board and choose a basic configuration that does not
cause a resource conflict. You can also use the Computer
Setup (F10) Utility to reconfigure or disable devices to
resolve the resource conflict.

Device hardware is not
properly jumpered or
otherwise configured.

Read the device-specific configuration information and
check for incorrect settings or conflicts with other devices
already installed in the system.

Incorrect memory modules
were used in the upgrade, or
memory modules were
installed in the incorrect
location.

1.

Review the documentation that came with the system
to determine if you are using the correct memory
modules and to verify the proper installation.

2.

Observe the beeps and LEDs on the front of the
workstation. Refer to POST error messages
on page 127 to determine possible causes.

PCI Express power cable
might be plugged into the
wrong connector on the
system board.

Connect the auxiliary PCI Express power cable to the PCI
Express card.

Memory is installed incorrectly
or is bad.

1.

Reseat DIMMs.

2.

Replace DIMMs one at a time to isolate the faulty
module.

3.

Replace third-party memory with HP memory.
Replace the system board.

Video card is not seated
properly or is bad, or system
board is bad.

For systems with a graphic card:
1.

Reseat the graphics card.

2.

Replace the graphics card.

3.

Replace the system board.

Solving network problems
These guidelines do not discuss the process of debugging the network cabling.
Table 5-12 Network problems
Problem

Cause

Solution

Wake-on-LAN feature is not
functioning.

Wake-on-LAN is not enabled.

Use the Network control application to enable Wake-onLAN.

Network driver does not detect
network controller.

Network controller is disabled.

Run the Computer Setup and enable network controller.

Incorrect network driver.

Verify the network controller documentation for the correct
driver or obtain the latest driver from the manufacturer
website.
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Table 5-12 Network problems (continued)
Problem

Solution

Network status link light does not
illuminate or it never flashes.

No active network is detected.

Verify cabling and network equipment for proper
connection.

The network status light should
flash when there is network
activity.

Network controller is not set up
properly.

Use the Network control application to verify that the
device is working properly.

Network driver is not properly
loaded.

Reinstall network drivers.

System cannot auto-sense the
network.

Disable auto-sensing capabilities and force the system
into the correct operating mode.

The cable is not securely
connected.

Be sure that both ends of the data cable are securely
connected.

The cable is attached to the
incorrect connector.

Be sure that the cable is attached to the correct connector.

There is a problem with the cable
or a device at the other end of the
cable.

Be sure that the cable and device at the other end are
operating correctly.

Network controller interrupt is
shared with an expansion board.

Under the Computer Setup (F10) Utility Advanced menu,
change the resource settings for the board.

The network controller
is defective.

Replace the network interface controller (NIC).

Network drivers are not loaded, or
driver parameters do not match
current configuration.

1.

Ensure the network drivers are loaded and that the
driver parameters match the configuration of the
network controller.

2.

Ensure the correct network client and protocol is
installed.

Diagnostics reports a failure.

Diagnostics passes, but the
workstation does not
communicate with the network.

Network controller stopped
working when an expansion
board was added to the
workstation.

Network controller stops working
without apparent cause.

New network card will not boot.
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Cause

The network controller is not
configured for this workstation.

Double-click the Network icon in the Control Panel and
configure the network controller.

Network controller interrupt is
shared with an expansion board.

Under the Computer Setup (F10) Utility Advanced menu,
change the resource settings for the board.

The network controller requires
drivers.

Verify that the drivers were not accidentally deleted when
the drivers for a new expansion board were installed.

The expansion board installed is a
network card and conflicts with the
embedded network card.

Under the Computer Setup (F10) Utility Advanced menu,
change the resource settings for the board.

The files containing the network
drivers are corrupted.

Reinstall the network drivers, using the Restore Plus! CD.

The cable is not securely
connected.

Be sure that both ends of the cable are securely attached
to the correct devices.

The network controller is
defective.

Replace the NIC.

New network card might be
defective or might not meet
industry-standard specifications.

Install a working, industry-standard NIC, or change the
boot sequence to boot from another source.
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Table 5-12 Network problems (continued)
Problem

Cause

Solution

Cannot connect to network
server when attempting remote
system installation.

The network controller is not
configured properly.

Verify network connectivity, that a DHCP Server is
present, and that the Remote System Installation Server
contains the NIC drivers for your NIC.

System setup utility reports
unprogrammed EEPROM.

Unprogrammed EEPROM.

Flash the ROM. You can download the most recent ROM
images from: http://www.hp.com/support/
workstation_swdrivers

Solving memory problems
CAUTION: Hewlett-Packard does not support mixing ECC and non-ECC memory. If ECC and nonECC memory are mixed, the workstation will not boot the operating system.
Table 5-13 Memory problems
Problem
Operating system will not boot or
does not function properly after
installing additional memory
modules.

Cause
Memory module is not the
correct type or speed or the
new memory module is not
seated properly.

Solution
Replace module with the correct industry-standard device
for the workstation.

ECC and non-ECC memory modules cannot be mixed.
Out of memory error.

Memory configuration might
not be correct.

Use the Device Manager to verify memory configuration.

You have run out of memory to
run the application.

Verify the application documentation to determine the
memory requirements.

Memory count during POST is
incorrect.

The memory modules might
not be installed correctly.

Verify that the memory modules have been installed
correctly and that proper modules are used.

Insufficient memory error during
operation.

Excess Terminate and Stay
Resident programs (TSRs) are
installed.

Delete any TSRs that you do not need.

You have run out of memory
for the application.

Verify the memory requirements for the application or add
more memory to the workstation.

Memory is installed incorrectly
or is faulty.

1.

Reseat DIMMs.

2.

Replace DIMMs one at a time to isolate the faulty
module.

3.

Replace third-party memory with HP memory.

4.

Replace the system board.

Power LED flashes red 5 times,
once every second, followed by a
2-second pause, and the
workstation beeps 5 times.
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Solving processor problems
Table 5-14 Processor problems
Problem
Poor performance is experienced.

Power LED is red and stays on.

Cause
Processor is hot.

Processor is not seated
properly or not installed.

Solution
1.

Ensure the airflow to the workstation is not blocked.

2.

Ensure the fans are connected and working properly
(some fans only operate when needed).

3.

Ensure the processor heatsink is installed properly.

1.

Verify that the processor is present.

2.

Reseat the processor.

Solving DVD problems
Table 5-15 DVD problems
Problem
Workstation will not boot from DVD
drive.

DVD devices are not detected or
driver is not loaded.
Movie will not play in the DVD drive.

Cannot eject CD (tray-load unit).

CD-RW, DVD-ROM, or DVD-R/
RW drive cannot read a disc
or takes too long to start.
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Cause

Solution

The DVD boot is not enabled
through the Computer Setup
(F10) Utility.

Run the Computer Setup (F10) Utility and enable booting
to removable media and verify boot order settings.

Non-bootable CD in drive.

Try a bootable CD in the drive.

Drive is not connected properly 1.
or not properly configured.
2.

Reconnect power and data cables to the drive.
Install correct device driver.

Movie might be regionalized
for a different country.

See the documentation that came with the DVD drive.

Decoder software is not
installed.

Install decoder software.

CD not properly seated in the
drive.

1.

Power off the workstation and insert a thin metal rod
into the emergency eject hole and push firmly.

2.

Slowly pull the tray out from the drive until the tray is
fully extended, then remove the disc.

CD has been inserted upside
down.

Reinsert the CD with the label facing up.

The DVD-ROM drive takes
longer to start because it has to
determine the type of media
played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive
determine the type of media being played. If the disc still
does not start, read the other solutions listed for this topic.

CD or DVD disc is dirty.

Clean CD or DVD with a CD cleaning kit.
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Table 5-15 DVD problems (continued)
Problem

Cause
Windows does not detect the
DVD-ROM drive.

Recording audio CDs is difficult or
impossible.

Wrong or poor quality media
type.

Solution
1.

Use Device Manager to remove or uninstall the
device in question.

2.

Restart the workstation and let Windows detect the
device.

1.

Use a slower recording speed.

2.

Verify that you are using the correct media for the
drive.

3.

Try a different brand of media. Quality varies widely
between manufacturers.

Solving Internet access problems
Table 5-16 Internet access problems
Problem

Cause

Solution

Unable to connect to the Internet.

Internet Service Provider (ISP)
account is not set up properly.

Verify Internet settings or contact the ISP for assistance.

Modem is not set up properly.

Reconnect the modem. Verify the connections are correct
using the quick setup documentation.

Web browser is not set up
properly.

Verify that the web browser is installed and set up to work
with your ISP.

Cable/ DSL modem is not
plugged in.

Plug in cable/DSL modem. You should see a “power” LED
on the front of the cable/DSL modem.

Cable/DSL service is not
available or has been
interrupted because of bad
weather.

Try connecting to the Internet at a later time or contact your
ISP. (If the cable/DSL service is connected, the “cable” LED
light on the front of the cable/DSL modem will be on.)

The CAT5 10/100/1000 cable
is disconnected.

Connect the CAT5 10/100/1000 cable between the cable
modem and the workstations RJ-45 connector. (If the
connection is good, the “PC” LED on the front of the cable/
DSL modem will illuminate.)

IP address is not configured
properly.

Contact the ISP for the correct IP address.

Cookies are corrupted.

1.

Select Start>Control Panel.

2.

Double-click Internet Options.

3.

On the General tab, click the Delete Cookies button.

Cannot automatically launch
Internet programs.

You must log on to the ISP
before some programs will
start.

Log on to the ISP and launch the desired program.

Internet takes too long to download
websites.

Modem is not set up properly.

1.

Select Start>Control Panel.

2.

Continue with step #2.

3.

Double-click System. Click the Hardware tab.

4.

In the Device Manager area, click the Device
Manager button.
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Table 5-16 Internet access problems (continued)
Problem
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Cause

Solution
5.

Double-click Ports (COM & LPT).

6.

Right-click the COM port your modem uses, then
click Properties.

7.

Under Device status, verify that the modem is working
properly.

8.

Under Device usage, verify the modem is enabled.

9.

If there are further problems, click the Troubleshoot
button and follow the on-screen instructions.
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Troubleshooting checklist
Before running any of the diagnostic utilities, use the following checklist to find possible solutions for
workstation or software problems.
●

Are the workstation and monitor connected to a working electrical outlet?

●

Is the workstation powered on?

●

Is the green power light illuminated?

●

Is the monitor powered on?

●

Is the green monitor light illuminated?

●

Adjust the monitor brightness and contrast controls if the monitor is dim.

●

Press and hold any key. If the system beeps, then the keyboard is operating correctly.

●

Check all cables for loose or incorrect connections.

●

Reconfigure the workstation after installing a non-Plug and Play expansion board or other option,
such as a diskette drive.

●

Are all of the necessary device drivers installed?

●

Have all printer drivers been installed for each application?

●

Remove all diskettes and CDs from the drives before you apply power to the system.

●

Ensure your workstation is running the latest BIOS version, drivers, and software updates.
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LED color definitions
A multicolor LED is located on the front panel of your workstation. The following table describes the
significance of each LED color.
Table 5-17 LED color definitions
LED state
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LED color

System status

Solid

Green

System is on.

Flashing

Green

System is in Standby.

Solid or flashing

Red

System has experienced an error. Refer
to Diagnostic error codes on page 102

None

No light

System is in Hibernate, or it is off.
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HP Insight Diagnostics Offline Edition
The HP Insight Diagnostics utility enables you to perform diagnostic testing and to view critical computer
hardware and software configuration information from various sources.

Key features and benefits
The HP Insight Diagnostics utility simplifies the process of effectively identifying, diagnosing, and
isolating the hardware issues, and helps provide a higher level system availability. In addition to robust
management tools, it also provides service tools can be invaluable in quickly resolving system problems.
You can use the HP Insight Diagnostics tool to streamline the service process and help resolve problems
quickly by providing the detailed information required at the time you place a service call. The primary
information requirement (the information that provides the greatest insight into potential system issues)
is the configuration of the system. Typical uses of the HP Insight Diagnostics tool are:
●

Testing and diagnosing apparent hardware failures.

●

Documenting system configurations for upgrade planning, standardization, inventory tracking,
disaster recovery, and maintenance.

●

Sending configuration information to another location for more in-depth analysis.

Theory of operation
Insight Diagnostics Offline Edition operates in offline mode only. The operating system is not running
and software information from the system is not available to the diagnostics. The utility Offline Survey,
however, is available to display the current system configuration.
The Insight Diagnostics Test feature provides the capability to test the functionality of all the major
hardware components in the system. The Test feature is designed to be flexible to enable you to
customize test selections by providing different modes and types of testing. Test modes include the
following:
●

Quick Test provides a predetermined script where a sample of each hardware component is
exercised and requires no user intervention.

●

Complete Test provides a predetermined script during which each hardware component is fully
tested. You can select Interactive or Unattended tests. This will change the devices tested during
the Complete Test. There are more tests available in the interactive mode, but these require user
intervention.

●

Custom Test provides the most flexibility in controlling the testing of a system. The Custom Test
mode enables you to specifically select which devices, tests, and test parameters are run. You can
select tests that do not require any user interaction through the Interactive and Unattended tests
modes.

Using the Diagnostic Utility on CD
HP Insight Diagnostics is available on the Documentation Library CD that was shipped with your
workstation.
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To start the diagnostic utility on the Documentation Library CD:
1.

Power on your workstation and press the F10 key during the initial boot process to enter the
Computer Setup (F10) Utility.

2.

Select your language from the list and press the Enter key. In the Computer Setup (F10) Utility
menu, four headings are displayed: File, Storage, Security, and Advanced. There may be other
headings depending on the workstation.

3.

Use the right arrow key to select Storage.

4.

Use the down arrow key to select Boot Order, and press Enter.

5.

Select CD-ROM Drive and enable it as a bootable device by pressing the F5 key . Default setting
is Enabled.
NOTE: The F5 key is an enable/disable toggle control. Pressing the F5 key again disables the
device.

6.

Set the CD-ROM Drive to the top of the boot order. To do this, select CD-ROM, press the Enter
key, and use the up arrow to move it to the top of the boot order.

7.

To apply and save changes, press the F10 key, and select File>Save Changes and Exit

8.

Insert the Documentation Library CD into the workstation.

9.

Restart your system to automatically launch the HP Insight Diagnostics tool.

Downloading the latest diagnostic utility
To download the latest diagnostic utility, complete the following:
1.

See Web site:http://www.hp.com/support/workstation_swdrivers.

2.

Click the Support & Drivers link.

3.

Select the Download driver and software radio button.

4.

Enter your product number (xw4550) in the text box and press the Enter key.

5.

Select your operating system.

6.

Click the Diagnostic link.

7.

Locate HP Insight Diagnostics Offline and click Download.

The HP Insight Diagnostic User Interface
The Insight Diagnostics home page contains the following tabs, which separate the major functions of
Insight Diagnostics.
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●

Survey

●

Test

●

Status

●

Help

●

Log
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Survey tab
The Survey menu enables access to important system configuration information, and offers both a
summary and advanced view. The Summary view limits the amount of data displayed, while the
Advanced view shows all the data in the selected category. All of the following categories of information
are available on the Survey menu:
●

Overview - Gives you a listing of general information about the computer.

●

All - Gives a listing of all information about the computer.

●

Architecture - Shows the type of bus the computer uses as well as BIOS information. In addition,
if the bus is PCI, information about the PCI configuration is displayed.

●

Asset Control - Shows the serial number of the computer and also provides processor information.

●

Communication - Shows information about the computer parallel (LPT) and serial (COM) port
settings, USB, and network controller information.

●

Graphics - Shows information about the graphics subsystem of the computer.

●

Input Devices - Shows information about the type of keyboard and mouse.

●

Memory - Shows information about all memory in the computer, including memory on the board
and any memory modules installed.

●

Miscellaneous - Shows information obtained from the computers configuration memory (CMOS),
BIOS data area, Interrupt Vector table, and diagnostics component information.

●

Storage - Shows information about storage media connected to the computer, including all hard
drives, diskette drives, and optical drives.

●

System - Shows product type, processor type and speed, coprocessor information, and information
about all ROMs in the computer.

Test tab
The Insight Diagnostics utility provides the capability to test all the major pieces of hardware in the
system. You can select from several types of tests:
●

Quick Test - Provides a predetermined script during which a sample of most hardware components
is exercised and requires no user intervention.

●

Complete Test - Provides a predetermined script during which most hardware components are
fully tested. You can select Interactive or Unattended tests. This will change the devices tested
during the Complete Test. More tests are available in the interactive mode, but these require user
intervention.

●

Custom Test - Provides the most flexibility in controlling the testing of a system. The Custom Test
mode enables you to specifically select which devices, tests, and test parameters are run. You can
select tests that do not require any user interaction through the Interactive and Unattended test
modes. More tests are available in the interactive mode, but these tests require user intervention.

To begin testing:
1.

Click the Test tab.

2.

Select Type of Test to perform and then select Test Mode, either Interactive or Unattended.
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3.

4.

Choose how you want the test to be executed, either Number of Loops or Total Test Time.
●

When choosing to run the test over a specified number of loops, enter the number of loops to
perform.

●

If you want to run the diagnostic test for a specified time period, enter the amount of time in
minutes.

Click Begin Testing in the lower right corner of the display to start the test.

While tests are being performed, you can monitor the progress by viewing the Status tab. Any errors
that are detected are summarized in the Error Log. Select Save to save the report to diskette drive or
a USB Key Drive if attached.
If the diagnostics utility detects an error during a test, the user can mouse-over the failed text in the
Status tab to display additional information for the type of error and the error code.
To view all test failure information, click the Error Log. To view the status of all testing that has been
performed, click the Log tab.

Status tab
The Status tab displays the status of the selected tests. The type of test executed (for example,
Quick, Complete, Custom) is displayed. The main progress bar displays the percent complete of the
current set of tests. While testing is in progress, Cancel Testing is displayed. This selection will cancel
the test job.
After testing has completed, the Cancel testing button is replaced with two buttons, Select New
Tests and Retest. The Select New Tests button enables you to go back to the previous test selection
page to select a new set of tests. The Retest button retests the last set of tests executed. This enables
you to rerun the set of tests without having to go back to the test selection page.
The Status page also shows:
●

The devices being tested

●

The tests that are running

●

The overall Test time

●

The individual Test times

●

The condition status of each test

Log tab
The Log tab provides of two views; Test Log and Error log:
Test Log - Displays all tests that have been executed, number of times the test has been executed,
number of times the test failed, and the time it took to complete the test. The Clear Test Log button will
clear the contents of the Test Log.
Error Log - Displays the tests that have failed during the diagnostic testing. Besides displaying the
device and test, this section might also include error details. The description section describes the error
that the diagnostic test found. The Recommended Repair will give a recommended action that should
be performed to resolve the failed hardware. The error count is the number of times the test has failed.
The Clear Error Log button will clear the contents of the Error Log.
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Help tab
The Help tab has three views; HP Insight Diagnostics, Error Codes, and Test Components:
●

HP Insight Diagnostics—Provides introductory and detailed information about Insight Field
Diagnostics.

●

Error Codes - Provides error code listings. It includes device tested, message, and recommended
repair information.

●

Test Components - Reloads and refreshes all components and display component details after
the refresh.
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POST error messages
Power On Self Test (POST) is a program run at startup that initializes and runs some tests on installed
hardware. An audible and/or visual message occurs if the POST encounters a problem. The POST
checks the following items to ensure that the workstation system is functioning properly:
●

Keyboard

●

Memory modules

●

Diskette drives

●

All SATA mass storage devices

●

Processors

●

Controllers

NOTE: If the power-on password is set, a key icon appears on the screen while POST is running. To
continue, you must enter the password for your workstation.
Table 5-18 POST error messages
Screen message
101—Option ROM Error

102—System Board Failure

103—System Board Failure

System ROM checksum.

DMA, timers, and so on.

DMA, timers, and so on.

Recommended action
Verify the correct ROM:
1.

Flash the ROM if needed.

2.

If an expansion card was recently added, remove
it and see if the problem remains.

3.

Clear CMOS. If the message disappears, there
might be a problem with the expansion card

4.

Replace the system board.

1.

Clear CMOS.

2.

Remove expansion boards.

3.

Replace the system board.

1.

Clear CMOS.

2.

Remove expansion boards.

3.

Replace the system board.

110—Out of Memory for
Option ROMs

Option ROM for a device was unable
to run due to memory constraints.

Run the Computer Setup (F10) Utility and enable the
ACPO/USB Buffers at Top of Memory under the
Advanced>Power-On option.

162—System Options Not Set

Configuration incorrect. RTC battery
might need to be replaced.

1.

Run Computer Setup (F10) Utility.

2.

Set the date and time under Control Panel or in
F10 Setup, depending on the operating system.

3.

If the problem persists, replace the RTC battery.

Invalid time or date in configuration
memory.

1.

Set the date and time under Control Panel or in
F10 Setup depending on the operating system.

RTC battery might need to be
replaced.

2.

If the problem persists, replace the RTC battery.

163—Time and Date Not Set
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Probable cause
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Table 5-18 POST error messages (continued)
Screen message

Probable cause

Recommended action

CMOS jumper might not be properly
installed.
164—Memory Size Error

201—Memory Error

Memory configuration is incorrect.

RAM failure.

1.

Run Computer Setup (F10) Utility or Windows
utilities.

2.

Be sure memory modules (if any) are installed
properly.

3.

If third-party memory has been added, test using
HP memory only.

4.

Verify proper memory module type.

1.

Run Computer Setup (F10) Utility or Windows
utilities.

2.

Ensure that memory and continuity modules are
installed correctly.

3.

Verify proper memory module type.

4.

Remove and replace memory modules one at a
time to isolate faulty module.

5.

Replace the faulty memory modules.

6.

If error persists after replacing memory modules,
replace the system board.

202—Memory Type Mismatch

Memory modules do not match each
other.

Replace memory modules with matched sets.

207—ECC Corrected Single
Bit Errors

Single-bit ECC error.

1.

Verify proper memory module type.

2.

Insert the DIMM in another memory socket.

3.

Replace memory module if problem persists.

1.

Reseat the processor in its socket.

2.

If the processor does not respond, replace it.

A memory module in memory socket
identified in the error message is
missing critical SPD information or is
incompatible with the chipset.

1.

Verify proper memory module type.

2.

Insert the DIMM in another memory socket.

3.

Replace memory with a module conforming to the
SPD standard.

214—DIMM Configuration
Warning

DIMMs not installed correctly (not
paired correctly).

Refer to the service label on the inside of the access
panel for correct memory configurations and reseat the
DIMMs accordingly.

215—Memory Mismatch
Warning

There are one or more mismatched
pairs of DIMMs between channel A and
channel B. Some memory has been
disabled. Install matching pairs or
remove the mismatched DIMMs from
channel B.

See the illustration on the side access panel for the
correct memory configurations and reseat the DIMMs
accordingly.

216—Memory Size Exceeds
Maximum Supported

The amount of memory installed
exceeds that supported by the
hardware.

1.

Verify the maximum amount of memory your
system can support.

2.

Remove the excessive memory.

212—Failed Processor

213—Incompatible memory
Module

Processor has failed to initialize.
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Table 5-18 POST error messages (continued)
Screen message
301—Keyboard Error

303—Keyboard Controller
Error
304—Keyboard or System
Unit Error

Probable cause
Keyboard failure.

I/O board keyboard controller.

Keyboard failure.

1.

Reconnect the keyboard to different USB
connector with workstation powered off.

2.

Check the connector for bent or missing pins.

3.

Ensure that none of the keys remain in the pressed
position.

4.

Replace the keyboard.

1.

Reconnect keyboard with workstation turned off.

2.

Replace the system board.

1.

Reconnect the keyboard with workstation turned
off.

2.

Ensure that none of the keys remain in the pressed
position.

3.

Replace keyboard.

4.

Replace system board.

410—Audio Interrupt Conflict

IRQ address conflicts with another
device.

Reset the IRQ.

411—Network Interface Card
Interrupt Conflict

IRQ address conflicts with another
device.

Reset the IRQ.

501—Display Adapter Failure

Graphics display controller.

1.

Reseat the graphics card (if applicable).

2.

Clear CMOS.

3.

Verify that the monitor is attached and turned on.

510—Splash Screen image
corrupted

Splash Screen image has errors.

Install latest version of SoftPaq to restore image. To
download the most recent SoftPaq version, see:
http://www.hp.com/support/workstation_swdrivers

511—CPU, CPUA, or CPUB
Fan not detected

Fan is not connected or might have
malfunctioned.

1.

Reseat the fan cable.

2.

Reseat the fan.

3.

Replace the fan.

1.

Reseat the chassis, rear chassis, or front chassis
fan cable.

2.

Reseat the chassis, rear chassis, or front
chassis fan.

3.

Replace the chassis, rear chassis, or front
chassis fan.

1.

Reseat the processor or chassis fan.

2.

Replace the processor or chassis fan.

1.

Run the Computer Setup (F10) Utility.

2.

Verify and replace cables.

3.

Clear CMOS.

512—Chassis, rear chassis, or Fan is not connected, might have
front chassis fan not detected malfunctioned.

514—CPU or Chassis Fan not Processor fan is not connected or
detected
might have malfunctioned.
601—Diskette Controller Error

ENWW

Recommended action

Diskette controller circuitry or diskette
drive circuitry incorrect.
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Table 5-18 POST error messages (continued)
Screen message

605—Diskette Drive Type
Error

611—Primary Diskette Port
Address Assignment Conflict

Probable cause

Mismatch in drive type.

Configuration error.

Recommended action
4.

Replace diskette drive.

5.

Replace the system board.

1.

Run the Computer Setup (F10) Utility.

2.

Disconnect any other diskette controller devices
(tape drives).

3.

Clear CMOS.

1.

Run the Computer Setup (F10) Utility.

2.

Remove expansion cards.

3.

Clear CMOS.

912—Computer Cover Has
Been Removed Since Last
System Start Up

N/A

No action required.

914—Hood Lock Coil is not
Connected

Hood lock mechanism is missing or not
connected.

1.

Reconnect or replace hood locking mechanism.

2.

Reseat or replace hood locking mechanism cable.

916—Power Button Not
Connected

The power button is not connected.

Connect power button.

917—Front Audio Not
Connected

The front audio cable is not connected.

Connect front audio cable.

918—Front USB Not
Connected

Front USB is not connected.

Connect front USB cable.

919—MultiBay Riser Not
Connected

MultiBay riser is not connected.

Connect MultiBay riser.

960—Processor Overtemp
occurred

The ambient temperature could
exceed operating limits
(maximum=95oF, 35oC), or there are
obstructions to airflow, including dust
build up.

1.

Be sure you are not operating the system in an
environment that exceeds 95oF (35oC).

2.

Disconnect power and open the access panel.

3.

Verify that cables are not blocking processor
heatsink fans or front fan, if installed.

4.

Verify that there is not excessive dust on major
components.

5.

If airflow is acceptable and there is not excessive
dust, the thermal sensing circuitry has failed on the
processors or on the system board. You must
replace the processors and/or the system board.

1.

Remove any Comm port expansion cards.

2.

Clear CMOS.

3.

Reconfigure card resources and run the Computer
Setup (F10) Utility.

4.

Run the Computer Setup (F10) Utility or Windows
utilities.

1.

Remove any Comm port expansion cards.

2.

Clear CMOS.

1151—Serial Port 1 Address
Conflict Detected

1152—Serial Port 2 Address
Conflict Detected

Both external and internal serial ports
are assigned to COM1.

Both external and internal serial ports
are assigned to COM2.
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Table 5-18 POST error messages (continued)
Screen message

1155—Serial Port Address
Conflict Detected

Both external and internal serial ports
are assigned to same IRQ.

Recommended action
3.

Reconfigure card resources and run the Computer
Setup (F10) Utility.

4.

Run the Computer Setup (F10) Utility or Windows
utilities.

1.

Remove any Comm port expansion cards.

2.

Clear CMOS.

3.

Reconfigure card resources and run the Computer
Setup (F10) Utility.

4.

Run the Computer Setup (F10) Utility or Windows
utilities.

1201—System Audio Address
Conflict Detected

Device IRQ address conflicts with
another device.

Reset the IRQ.

1720 SMART Hard Drive
Detect Imminent Failure

Hard drive is about to fail. (Some hard
drives have a firmware patch that will
fix an erroneous error message.)

1.

Determine if hard drive is giving correct error
message.

2.

Run the Drive Protection System test if applicable.

3.

Apply firmware patch if applicable
(see: http://www.hp.com/support/
workstation_swdrivers).

4.

Back up contents and replace hard drive.

1.

Be sure that any jumpers are set correctly, and
that power and drive cables are connected, both
to the drive and the system board.

2.

Verify that the cables are the correct cables for
your computer model. If this message persists,
you might need service for your workstation.

1.

Be sure that any jumpers are set correctly and that
power and drive cables are connected, both to the
drive and the system board.

2.

Verify that the cables are the correct cables for
your computer model. If this message persists,
you may need service for your workstation.

1.

Run the Computer Setup (F10) Utility.

2.

Clear CMOS.

3.

Verify cable seating/jumper settings.

4.

Run hard drive diagnostics.

5.

Disconnect additional drives.

6.

Run the Drive Protection System test if available.

7.

Replace the hard drive.

8.

Replace the system board.

1780—Disk 0 Failure

1781—Disk 1 Failure

1782—Disk Controller Failure
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Probable cause

The drive is not installed correctly or
has failed.

The drive is not installed correctly or
has failed.

Hard drive circuitry error.
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Table 5-18 POST error messages (continued)
Screen message
1790—Disk 0 Error

1791—Disk 1 Error

1792—Secondary Disk
Controller Failure

1793—Secondary Controller
or Disk Failure

Probable cause
The drive is not installed correctly or
has failed.

The drive is not installed correctly or
has failed.

Hard drive circuitry error.

Hard drive circuitry error.

Recommended action
1.

Be sure that any jumpers are set correctly and that
power and drive cables are connected, both to the
drive and the system board.

2.

Verify that the cables are the correct cables for
your computer model. If this message persists,
you may need service for your workstation.

1.

Be sure that any jumpers are set correctly and that
power and drive cables are connected, both to the
drive and the system board.

2.

Verify that the cables are the correct cables for
your computer model. If this message persists,
you may need service for your workstation

1.

Run Computer Setup (F10 Setup).

2.

Clear CMOS.

3.

Verify cable seating/jumper settings.

4.

Run hard drive diagnostics.

5.

Disconnect additional drives.

6.

Run the Drive Protection System test if available.

7.

Replace the hard drive.

1.

Run the Computer Setup (F10) Utility.

2.

Clear CMOS.

3.

Verify cable seating/jumper settings.

4.

Run hard drive diagnostics.

5.

Disconnect additional drives.

6.

Run the Drive Protection System test if available.

7.

Replace the hard drive.

1801—Microcode Patch Error

Processor not supported by ROM
BIOS.

Upgrade BIOS to proper version.

1802—Processor Not
Supported

The system board does not support the
processor.

Replace the processor with a compatible one.

1803-BIOS Update Needed for This BIOS revision does not support
Processor
the installed processor.

Install the latest BIOS downloaded from
http://www.hp.com/support/workstation_swdrivers.

1998—Master Boot Record
has been lost

The previously saved copy of the MBR Run the Computer Setup (F10) Utility and save the
has been corrupted.
MBR of the current bootable disk.

Invalid Electronic Serial
Number

Electronic serial number has become
corrupted.

Run the Computer Setup (F10) Utility. If Setup already
has data in the field or will not allow the serial number
to be entered, download from http://www.hp.com/
support/workstation_swdrivers and run the utility
SP5572.EXE (SNZERO.EXE).
Run the Computer Setup (F10) Utility and try to enter
serial number under Security, System ID, and save the
changes.
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Table 5-18 POST error messages (continued)
Screen message
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Probable cause

Recommended action

ECC Multiple Bit Error
Detected in Memory Module

Chipset has detected more than one
bad bit in a 64-bit quadword of the
memory array.

Replace the memory module.

Parity Check 2

Parity RAM failure.

Run the Computer Setup (F10) Utility and Diagnostic
utilities.
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6

Configuring password security and
resetting CMOS

Preparing to configure passwords
This workstation supports the following security password features, which can be established through
the Computer Setup (F10) Utility menu:
●

Setup password

●

Power-on password

When you establish a setup password, only the power-on password is required to access the Computer
Setup (F10) Utility and any other information on the workstation. When you establish both passwords,
only the setup password will give you access to the Computer Setup (F10) Utility.
When both passwords are set, the setup password can also be used in place of the power-on password
as an override to log in to the workstation, which is a useful feature for a network administrator.
If you forget the password for the computer, two methods are available for clearing that password so
you can gain access to the information on the workstation:
●

Reset the password jumper

●

Use the Clear CMOS spring-loaded slider switch.

CAUTION: Pushing the CMOS switch to detente resets CMOS values to factory defaults and erases
any customized information, including passwords, asset numbers, and special settings. It is important
to back up the workstation CMOS settings before resetting them in case they are needed later. To back
up the CMOS settings, use the Computer Setup (F10) Utility and run the Save to Diskette option from
the File menu.
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Resetting the password jumper
To disable the power-on or setup password features and clear the power-on and setup passwords:
1.

Shut down the operating system, and power off the workstation and any external devices.
Disconnect the power cord of the workstation and any external devices from the power outlets.

2.

Disconnect the keyboard, monitor, and any other external devices that are connected to the
workstation.
WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, be sure
to disconnect the power cord from the line voltage power outlet and allow the internal system
components to cool before touching.
CAUTION: When the workstation is plugged in, the power supply always has voltage applied to
the system board even when the workstation is turned off. Failure to disconnect the power cord
can result in damage to the system.
CAUTION: Static electricity can damage the electronic components of the workstation or optional
equipment. Before beginning these procedures, be sure that you are discharged of static electricity
by briefly touching a grounded metal object.

3.

Remove the access panel.

4.

Locate the password header and jumper. The password header is E49 on the system board.
NOTE: The password jumper is green so that it can be easily identified. For assistance locating
the password jumper and other system board components, see the service label located on the
inside of the workstation access panel.

5.

Remove the jumper from either pin 1 or 2. Place the jumper on pins 1 and 2 (connecting both pins
together).

6.

Replace the access panel.

7.

Reconnect the external equipment.

8.

Plug in and power on the workstation. Allow the operating system to start. This process clears the
current passwords and disables the password features.

9.

To establish new passwords, repeat steps 1 through 4, replace the password jumper on either pin
1 or pin 2 (but not both), and repeat steps 6 through 8. Establish the new passwords in the Computer
Setup (F10) Utility.
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Clearing and Resetting the CMOS
The CMOS of the workstation stores password information and information about the workstation
configuration. This section describes the steps to successfully clear and reset the CMOS.

Using the CMOS switch
1.

Shut down the operating system, and power off the workstation and any external devices.
Disconnect the workstation power cord and any external devices from the power outlets.

2.

Disconnect the keyboard, monitor, and any other external devices that are connected to the
workstation.
WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, be sure
to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.
CAUTION: When the workstation is plugged in to a line voltage source, voltage is continuously
applied the system board even when the unit is powered off. Failure to disconnect the power cord
can result in damage to the system.
CAUTION: Static electricity can damage the electronic components of the workstation or optional
equipment. Before beginning these procedures, be sure that you are discharged of static electricity
by briefly touching a grounded metal object.

3.

Remove the access panel.
CAUTION: It is important to back up the workstation CMOS settings before resetting them in case
they are needed later. Activating the CMOS switch resets CMOS values to factory defaults and
erases any customized information, including passwords, asset numbers, and special settings. To
back up the CMOS settings, use the Computer Setup (F10) Utility and run the Save to Diskette
option from the File menu.

4.

Locate, press, and hold the CMOS switch in the detente position for five seconds.
NOTE: Ensure that the AC power cord is disconnected from the power outlet. The CMOS switch
does not clear CMOS if the power cord is connected.
NOTE: To locate the CMOS switch and other system board components, see the service label
located on the inside of the workstation access panel or the System board components
on page 58 section of this guide.

5.

Replace the access panel.

6.

Reconnect any external devices.

7.

Plug in and power on the workstation.
The workstation will power up for 3-to-5 seconds, then power off.
NOTE: You must reset the workstation passwords and any special configurations, along with the
system date and time.

ENWW

Clearing and Resetting the CMOS 137

Using the Computer Setup (F10) Utility to reset CMOS
1.

To reset CMOS using the Computer Setup (F10) Utility, access the Computer Setup (F10) Utility
menu. When the Computer Setup message appears in the lower-right corner of the screen, press
the F10 key. Press Enter to bypass the title screen, if necessary.
NOTE: If you do not press the F10 key while the message is displayed, the workstation must be
powered off, then on again, to access the utility.

2.

From the Computer Setup (F10) Utility menu, select File>Set Defaults and Exit. This restores the
soft settings that include boot sequence order and other factory settings. It does not, however,
force hardware rediscovery.
NOTE: You must reset the workstation passwords and any special configurations, along with the
system date and time.
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A

Appendix A—Workstation connector
pins

Connector pin descriptions
This appendix provides connector pin and signal descriptions for connectors used with the HP xw4550
Workstation.
Workstation Ethernet connector

Pin

Signal

1

(+) Transmit Data

2

(-) Transmit Data

3

(+) Receive Data

4

Unused

5
Unused
6
(-) Receive Data
7
Unused
8
Unused

Workstation serial connector

ENWW

Pin

Signal

1

Carrier Detect

2

Receive Data

3

Transmit Data

4

Data terminal ready

5

Signal ground

6

Data set ready

7

Request to Send

8

Clear to Send

9

Ring Indicator
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Workstation USB connector

Workstation IEEE 1394 connector

Microphone cable connector (1/8 inch)

Headphone cable connector (1/8 inch)

Line-in audio cable connector (1/8 inch)
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Pin

Signal

1

+5 VDC

2

- Data

3

+ Data

4

Ground

Pin

Signal

1

Power

2

GND

3

TPB-

4

TPB+

5

TPA-

6

TPA+

Pin

Signal

1 (Tip)

Audio

2 (Ring)

Power

3 (Shield)

Ground

Pin

Signal

1 (Tip)

Audio_Left

2 (Ring)

Audio_Right

3 (Shield)

Ground

Pin

Signal

1 (Tip)

Audio_In_Left

2 (Ring)

Audio_In_Right

3 (Shield)

Ground
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Line-out audiocable connector (1/8 inch)

Pin

Signal

1 (Tip)

Audio_Out_Left

2 (Ring)

Audio_Out_Right

3 (Shield)

Ground

SATA drive connector

Data Pins

Power Pins

Power Pins

Pin

Signal

Pin

Signal

Pin

Signal

S1

Ground

P1

3.3-V power

P8

5-V power

S2*

A+

P2

3.3-V power

P9

5-V power

S3*

A-

P3

3.3-V power

P10

Ground

S4

Ground

P4

Ground

P11

Reserved

S5**

B-

P5

Ground

P12

Ground

S6**

B+

P6

Ground

P13

12-V power

S7

Ground

P-7

5-V power

P14

12-V power

P15

12-V power

* S2 and S3 differential signal pair
**S5 and S6 differential signal pair
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Signal

Pin

Signal

Pin

Signal

1

Red Analog

6

GND

11

Monitor ID

2

Green Analog

7

GND

12

DDC Serial Data

3

Blue Analog

8

GND

13

Horizontal Sync

4

Monitor ID

9

+5V DC

14

Vertical Sync
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Workstation VGA connector

Pin
5

Signal

Pin

GND

10

Signal

Pin

GND

15

Signal
DDC Serial Clock

Workstation DVI-D connector

Pin

Signal

Pin

Signal

1

T.M.D.S DATA 2-

14

+5V POWER

2

T.M.D.S DATA 2+

15

GND

3

T.M.D.S DATA 2/4 SHIELD

16

HOT PLUG DETECT

4

T.M.D.S DATA 4-

17

T.M.D.S DATA 0-

5

T.M.D.S DATA 4+ 2

18

T.M.D.S DATA 0+

6

DDC CLOCK

19

T.M.D.S DATA 0/5 SHIELD

7

DDC DATA

20

T.M.D.S DATA 5-

8

ANALOG VERT. SYNC

21

T.M.D.S DATA 5+

9

T.M.D.S DATA 1-

22

T.M.D.S CLOCK SHIELD

10

T.M.D.S DATA 1+

23

T.M.D.S CLOCK+

11

T.M.D.S DATA 1/3 SHIELD

24

T.M.D.S CLOCK-

12

T.M.D.S DATA 3-

13

T.M.D.S DATA 3+

C5

GROUND

24-Pin Main power cable connector (mates with system board connector P1)

13

24

1

12
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Pin

Color

Signal

Pin

Color

Signal

Pin

Color

Signal

Pin

Color

Signal

1

Orange

+3.3V

7

Black

GND

13

Orange

+3.3V

19

Black

GND

2

Orange

+3.3V

8

Grey

POK

14

Blue

-12V

20

3

Black

GND

9

Purple

+5 Vaux 15

Black

GND

21

Red

+5V

4

Red

+5V

10

Yellow

+12 V

16

Green

PS_ON
_L

22

Red

+5V

5

Black

GND

11

Yellow

+12 V

17

Black

GND

23

Red

+5V

6

Red

+5V

12

Orange

+3.3V

18

Black

GND

24

Black

GND

4-Pin power (processor/memory/aux. sys. board) cable
connector (mates with system board connector P3)

CAUTION: The 4-pin power cable connector is the color white.
You must mate it ONLY with white system board connector P3.
Mating this cable with any other system board connector and
applying power might damage your system board and void your
warranty.

Auxiliary 6-pin power cable connector for optional PCI
Express graphics card

4

1

6

3

Reserv
ed

Pin

Color

Signal

1

BLK

GND

2

BLK

GND

3

BRN

+12VCPU

4

BRN

+12VCPU

Pin

Color

Signal

1

YEL

+12VCPU

2

YEL

+12VCPU

3

YEL

+12VCPU

4

BLK

GND

5

BLK

GND

6

BLK

GND

NOTE: This connector and optional cable connect between an installed PCI Express graphics card auxiliary
power connector and the system board “Graphic Pwr” connector P4 for graphics cards that use more than 75
watts of power.
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AUX_IN (auxiliary audio)

Internal USB system board 2x5 connector
The 2x5 internal USB system board connector can be mated to
either a wide 2x5 option cable connector or a narrow 1x5 option
cable connector.

Pin

Signal

1

AUX_LEFT

2

AGND

3

AGND

4

AUX_RIGHT

Pin

Signal

1

+5V

2

+5V

3

USB6#

4

USB7#

5
USB6
CAUTION: Possible equipment damage.
Always key all option connectors to the blank pin 9 position to
prevent damage to connectors and equipment. Always connect a
narrow 1x5 option cable connector to pins 1,3,5, and 7 only.
6
USB7
7
GND
8
GND
9
(pin not keyed)
10
(not connected)

System fan (rear chassis), processor fan, and PCI fan (front
chassis) system board connectors
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Pin

Signal

1

Ground

2

+12V

3

Tach

4

CMD

ENWW

Floppy (diskette) drive

Internal serial

ENWW

Pin

Signal

Pin

Signal

1

Ground

18

FLP_DIR#

2

FLP_LOWDEN#

19

Ground

3

unused

20

FLP_STEP#

4

FLP_WDO

21

Ground

5

unused

22

FLP_WR_D#

6

unused

23

Ground

7

Ground

24

FLP_WRTEN#

8

FLP_INDEX#

25

Ground

9

Ground

26

FLP_TRACK#

10

FLP_MOTOR#

27

Ground

11

Ground

28

FLP_WP#

12

Unused

29

Ground

13

Ground

30

FLP_RD_D#

14

FLP_SEL_A#

31

Ground

15

Ground

32

FLP_HD_SEL#

16

Unused

33

Ground

17

Ground

34

FLP_DSKCHG#

Pin

Signal

Pin

Signal

1

DTR2#

9

+5V

2

RXD2

10

+3.3V AUX

3

CTS2#

11

RTS2#

4

DSR2#

12

COMM_B_DET#

5

TXD2

13

DCD2#

6

R12#

14

-12V

7

Ground

15

+12V

8

Ground
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Appendix B—System board
designators

This appendix lists the system board designators for this system.
Designator

Silkscreen

Component

DIMM1A

DIMM1A

DIMM slot 1, channel A connector

DIMM1B

DIMM1B

DIMM slot 1, channel B connector

DIMM2A

DIMM2A

DIMM slot 2, channel A connector

DIMM2B

DIMM2B

DIMM slot 2, channel B connector

E49

Password Enable

Clear password header/jumper

J9

RJ 45 and dual USB in combined housing

J10

Quadruple stacked USB in combined housing

J20

SLOT3 PCI32/33

PCI slot

J21

SLOT4 PCI32/33

PCI slot

J31

SLOT2_PCIE x4(1)

PCI Express slot

J41

SLOT1_PCIE x16

PCI Express slot

J65

DVI-D Connector

J69

Combined VGA and Standard serial (COM 1)
connector in combined housing

J78

Double stacked audio jack

P1

Power Connector

Main power supply connector (24-pin)

P3

Power Connector

CPU 12V power connector (4–pin)

P4

Graphic Pwr

6-pin power (auxiliary PCI Express) cable
connector

P5

CONTROL PANEL

Front control panel connector

P6

SPK

Speaker connector

P8

PCI FAN

PCI fan connector (optional)

P9

SYS_FAN

System fan connector

P10

FLOPPY

Diskette drive connector

P11

AUX_IN

Internal Aux-in audio connector
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Designator

Silkscreen

Component

P23

FRONT AUDIO

Front audio connector

P24

FRONT USB

Front USB Connector

P52

COM2

Internal serial connector

P60-63

SATA0, SATA1, SATA2, SATA3

SATA Connector ports

P70

CPU_FAN

processor fan connector

P124

Hood Lock

Internal Hood Lock Connector

P125

Hood Sense

Internal Hood Sense Connector

P150

INTERNAL USB

Internal USB Connector

SW50

CMOS (Push slider to clear)

Clear CMOS slider switch SW50

XBT1

BATTERY

Battery socket connector

XU1

CPU

Processor chip
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Appendix C— Routine care

General cleaning safety precautions
●

Never use solvents or flammable solutions to clean the workstation.

●

Never immerse any component in water or cleaning solutions; apply any liquids to a clean cloth
and then use the cloth on the component.

●

Always unplug the workstation before cleaning the keyboard, mouse, or air vents.

●

Always disconnect the keyboard before cleaning it.

●

Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the workstation case
●

Follow the safety precautions presented in before cleaning the workstation.

●

To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

●

For stronger stains, use a mild dish-washing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

●

For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed because the alcohol will
evaporate quickly and not leave a residue.

●

After cleaning, always wipe the unit with a clean, lint-free cloth.

●

Occasionally clean the air vents on the workstation. Lint and other foreign matter can block the
vents and limit the airflow.

Cleaning the keyboard
CAUTION:
the keys.
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Use safety glasses equipped with side shields before attempting to clean debris from under

●

Follow the safety precautions presented in Service considerations on page 52 before cleaning the
keyboard.

●

Visible debris underneath or between the keys can be removed by vacuuming or shaking.

●

Canned, pressurized air can be used to clean debris from under the keys. Use caution because
too much air pressure can dislodge lubricants applied under the wide keys.
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●

If you remove a key, use a specially designed key puller to prevent damage to the keys. This tool
is available through many electronic supply outlets.
CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these keys
are improperly removed or installed, the keyboard might not function properly.

●

Clean under a key with a swab moistened with isopropyl alcohol and squeezed out. Be careful not
to wipe away lubricants necessary for proper key functions. Allow the parts to air dry before
reassembly.

●

Use tweezers to remove any fibers or dirt in confined areas.

Cleaning the monitor
●

Follow the safety precautions presented in Service considerations on page 52 before cleaning the
keyboard.

●

To clean the monitor, wipe the monitor screen with a towelette designed for cleaning monitors or
a clean cloth moistened with water.
CAUTION: Do not use sprays or aerosols directly on the screen—the liquid might seep into the
housing and damage a component.
Never use solvents or flammable liquids on the monitor because display or housing damage may
result.

Cleaning the mouse
1.

Follow the safety precautions presented in Service considerations on page 52 before cleaning the
mouse.

2.

Remove the mouse ball from the housing by removing the retaining plate.

3.

Clean the mouse ball.

4.

Pull out any debris from the ball socket, and wipe the ball with a clean, dry cloth.

5.

Reassemble the mouse.
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